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INTRODUCTION

Quantities 2 Plans

Quantities 2 Plans (Q2P) was developed by the Wisconsin Department of Transportation (WisDOT) to create a
single repository of bid item data for maintaining a live link between the engineer’s estimate, quantity calculations,
and the construction plan miscellaneous quantity (MQ) sheets. Q2P is a Microsoft® Excel® Add-in based
application that contains all the current WisDOT bid items with automatic updates capability (from the WisDOT
AASHTOWare Project Database).

MQ tables are created in Q2P and are able to be linked into Microsoft® PowerPoint® or AutoCAD® Civil 3D for MQ
plan sheet creation. The estimate cost data is updated by design staff from scoping phase through PS&E, at which
point the estimate is imported into AASHTOWare Project Preconstruction® (AWP Preconstruction). When a
project estimate is submitted to Central Office at PS&E phase, Q2P is no longer considered the official engineer’s
estimate. At this stage, region policy dictates whether Q2P is kept current with the changed data in AWP
Preconstruction (from PS&E review revisions, addenda, etc.)

The WisDOT Bureau of Information Technology Services (BITS) and WisDOT Q2P Support Committee maintain Q2P
(the Excel Add-in and the worksheet templates used by the add-in), and provide support via the
DOTQ2P@dot.wi.gov (DOT Q2P) email address. The WisDOT Estimating Group is an additional resource that
provides best practices and information related to construction cost estimating.

Visit https://wisconsindot.gov/Pages/doing-bus/eng-consultants/cnslt-rsrces/tools/estimating/est-q2p.aspx to

subscribe to the WisDOT Q2P email list for Q2P news or to find the name of power users in your region for support.
Notifications for updates, or tips & tricks, etc. are shared via this distribution list.

Confidentiality Notice

Engineering estimates are always treated as confidential before, during and after the letting by WisDOT. Engineer
estimate data should not be released outside of WisDOT with the exception of the Federal Highway Administration
and engineering consultants working directly for WisDOT. The State Transportation Agency (i.e. WisDOT) policy is
further explained in Appendix C.

When sharing information with the public, or when a general estimate is required in a project report (e.g. the
Work Zone Transportation Management Plan), obtain the project estimate range from region planning section’s
Public Report.
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USING QUANTITIES 2 PLANS

1. Before You Get Started

Quantities 2 Plans (Q2P) requires system files to be installed.

WisDOT Staff:
External Staff:

Quantities 2 Plans User Guide

Will need to contact the DOT IT Service Desk for installation of the necessary system files.
Will need to download the installer from the Q2P website.

5 * Q2P updates are pushed to WisDOT staff’s workstations by IT. Consultants must
download Q2P updates posted on the Q2P website.

As part of the installation process, each user will need to go through a few additional steps to finish the

installation of Q2P on your computer for your logon account. If Q2P ever needs to be re-installed, if you get a

new computer, or if another user needs to login and use Q2P on your computer, the following steps need to be

performed prior to the first use of Q2P.

& Settings

@ Home

I Find a setting Pl I

Apps

I i=  Apps & features e
i%  Default apps

[ Offline maps

[ Apps for websites

X Video playback

& Startup

Apps & features
Apps & features
Manage optional features
Manage app execution aliases

Search, sort, and filter by drive. If you would like to
uninstall or move an app, select it from the list.

[= o

Sort by: Name v Filter by: All drives

@l Q2P Excel Add-in 3.17 MB
1 5/9/2019

211
e Uninstall

Figure 1.1 Windows “Apps & Features” menu.

Select “Apps”.

ounswWwNE

button and click the “Finish” button.
7. After Q2P is repaired, you can close these windows and open up excel with a new workbook. If everything
worked, you should see a new Excel ribbon along the top titled “Q2P”.

75 Q2P Excel Add-in

Welcome to the Q2P Excel Add-in Setup Wizard

Select whether you want to repair or remove Q2P Excel Add-in.

@ Repair 2P Excel Adddn | @
() Remove Q2P Excel Add-in

Cancel < Back

Figure 1.2 Window with “Repair Q2P Excel Add-In” tool.

Go to your Start Menu and select “Settings” (Gear shaped icon)

In the next window that appears, make sure “Apps & Features” is selected (Figure 1.1).
In the search bar, type in “q2p”.
You’ll see an app titled Q2P Excel Add-in with two buttons available to press. Press the “Modify” button.
A window should pop up with two radio buttons (Figure 1.2). Select the “Repair Q2P Excel Add-in” radio

If you have any issues getting this far, please feel free to contact DOTQ2P@dot.wi.gov

Q2P is currently supported under Microsoft® Office 2012 and up with Windows 7 and up and must have the .NET
Framework 4.6 and up installed.
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2. Begin a New Project - Entering Project Information
1. Open a new Excel workbook and navigate to the Q2P ribbon tab (Figure 2.1). This tab houses all of Q2P’s
specific commands and functionality.

A A Q2P workbook can only handle a single project ID. If you are working on multiple project IDs

that will be LET together as one proposal and plan set, then you will need multiple Q2P
workbooks to be able to import each project IDs estimate into AWP separately and one
workbook to combine the quantity tables together for the projects’ MQ sheets.

S Book1 - Excel

Insert Page Layout Formulas Data Review  View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do \»_1 Share

ﬁ 4y Project Setup &3 Published Bid Items = *=Create MQ Sheet = Remove Bid Item ) Update Bid Item(s) E‘E)To Estimator XML @? From Estimator XML & About
[ Category Setup | [ Project Bid ltems =]i Rename MQ Sheet (EE Insert Bid Item(s) - Go to "Bid ltems” [}, To AWP Precon XML From AWP XML

Deny [, Checked By ﬁ@' Rebuild References O Round Up Quantity AE)‘ Order MQ Sheets [} Generate Cost Report

Project Data MQ Sheet Tool Export Import Help ~
Figure 2.1 Q2P-specific commands found under the Q2P tab.

2. Aninternet connection is required for this step, and the project setup window shown below, may take
10 seconds or more to display depending on your internet connection. Q2P will contact WisDOT’s AWP
server and copy the list of published Bid Items to this Q2P workbook. Select New (Figure 2.2) from the
Project section of the Q2P ribbon to initialize the project setup window (Figure 2.3) and enter all project
information. The information in Q2P must match FIIPS information EXACTLY.

If the project information does not match FIIPS exactly, errors will result when trying

=X
to export and upload to AWP Preconstruction.

2 The one exception to the rule above is if the project title uses the ampersand (&). If this is the
case, the XML export from Q2P will not successfully load into AWP. As a workaround, remove the
“&"” or replace it with “and” in the Q2P export XML then edit it back in once uploaded into AWP.

= T Book1 - Excel

File Home Insert Pagelayout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do |4 Share

Tj 41 Project Setup &1 Published Bid Items = *=Create MQ Sheet = Remove Bid Item %) Update Bid Item(s) E:lTo Estimator XML From Estimator XML &5 About

L] Category Setup [ Project Bid Items =] Rename MQ Sheet €= Insert Bid Item(s) - Go to "Bid ltems” [} To AWP Precon XML From AWP XML
M <53 ked By E@l Rebuild References O Round Up Quantity AE,‘ Order MQ Sheets [ Generate Cost Report
Project Data MQ Sheet Tool Export Import Help ~

Figure 2.2 The “New” button under the Project section of the Q2P ribbon.
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Project Setup

CONSTRUCTION ID:
TITLE
LIMITS:

HIGHWAY"

PROJECT MANAGER:

COUNTY:

PROGRAM CODE:

CONCEPT GODE: | ~]
NET G/L MILES: [0.000 g
PSE DATE:
LETDATE: [06/192018 [~

Quantities 2 Plans User Guide

Cancel

Figure 2.3 Project Setup window.

3. Select “OK” when finished to save the workbook. Use the 00000000_mqw.xIsx naming convention,
where 00000000 is the associated construction ID. Save the Q2P workbook in your project estimate
folder, or where your region’s policy dictates. A date or other version related text can be added to the
file name (e.g., 12345678_mqw-30REVIEW.xIsx).

4. Select Category Setup (Figure 2.4) from the Project section of the Q2P ribbon to initialize the category
setup window (Figure 2.3) and enter all category information. Select OK when finished. This process must
be repeated for each new category.

= =

1234-56-78 maw.xlsx - Excel

A

BLUEBEAM Acrobat Q Tell me what you want to do |~ Share

File Home Insert Formulas Data Review View Developer Inquire

ﬁ #Project Setup 7 Published Bid Items = *= Create MQ Sheet

" Category Setup | [ Project Bid Items =] Rename MQ Sheet EE Insert Bid [tem(s) 5 Go to "Bid Items"
% Checked By ] Rebuild References O Round Up Quantity AE,‘ Order MQ Sheets

Page Layout

2 Remove Bid Item &) Update Bid Item(s) | [} To Estimator XML
[#1 To AWP Precon XML

@Generate Cost Report

From Estimator XML 25 About

New

Project Data MQ Sheet Tool Export Import Help ~

Figure 2.4 The “Category Setup” button under the Project section of the Q2P ribbon.

Setup Category, Federal Work Type & Category Description... X
Category: Federal Work Type:
0010 ~ \ ~]
Category Description:
Funding:

Figure 2.5 Category Setup window.

Cancel
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11




Z* If category information must be updated, this is possible by selecting the existing
category from the Category Drop-down and entering the new information as needed

to overwrite the existing category.

This updating method also works for deleting unused categories, where you simply
need to select blank options to clear the existing category. (See section 6.2 Delete

Categories from Project for more information.)

Quantities 2 Plans User Guide

This information can all be obtained from FIIPS through Project > Funding... and clicking Category # 00n0

for more detailed information (See Figures 2.6 and 2.7). External users should contact the DOT Project

Manager to obtain this information. The information in Q2P must match FIIPS information EXACTLY.

Multidivisional

FIIP:

FIIPS - Funding

File Summariez  Cates
Description... F4

Projec Location... Fa
Estimate... FE

1234 Funding...

H - 2 Fedeal.. F&

0202 Admin
HMotes. .. Fi0
TIF... F11
FHWwia-37... Ctrl+F8
COR

qories

5

Figure 2.6 FIIPS menu navigation.

Category # 0020

Category estimate

wi Del wio Del % wiin State Fed app/
add-on add-on Type Limit Priority priority app. Demo ID
Category # 0010 Category estimate Category desc: Roadway Construction
Fed lmp Ty 0% 52,854,794 33
§2,.348,314 .47 2,283,835 46 FEDERAL Unlimited 1 0. ooo0x 383 LZ0E ) T
$587,078.62 $570,958 87  STATE Unlimited 1 20000 363 ) T
$2,935,393.09 52,854,794 33

Fedlmp Ty 14 $21,703.17
$17.852.73 417,362 54 FEDERAL Unlimited 1 0. oooz 383 LZ0E ) T
34 463.1%8 $4.340.63 STATE Unlimited 1 20. 000z 363 ) T
$22,315.91 $21,703 .17

Emk

Figure 2.7 FIIPS project information

Always use the dialog box to edit the category information and do not edit their headings (i.e.

“Categories”) on the “Bid ltems” worksheet.

Wisconsin Department of Transportation
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Setup Category, Federal Work Type & Category Description...

Category: Federal Work Type:
‘0010 » ‘ ‘()5 - 4R Maintenance, Resurfacing

Category Description

‘Rcadway Construction

Funding
[80% Federal 20% Statel

Figure 2.8 Categories, Federal Work Types and Funding entry in Q2P.

If the desired work type is not in the list, type it in (50 — New Tunnel, for example).

5. Save the changes made to this workbook. Saving (to your local computer or a network drive) will enable
Excel’s Autosave feature, reducing the risk of data loss in the event of a program crash.
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3. Bid Item Data
The Data section of the Q2P ribbon houses two bid item commands:

Published Bid Items and Project Bid Items

3.1 Published Bid Items

Q2P > Data > Published Bid Items (Figure 3.1) will display the most current list of bid items downloaded
from the AWP server (Figure 3.2). This is for informational purposes only.

= i 1234-56-78_maw.xlsx - Excel ] - O

File Home Insert Pagelayout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do A Share

Tj 0] Published Bid Items

4jProject Setup *+=Create MQ Sheet 2 Remove Bid ltem ) Update Bid Item(s) ' [} To Estimator XML = From Estimator XML &> About

N [4 Category Setup ‘7 Project Bid Items =] Rename MQ Sheet «j{ Insert Bid Item(s) 5 Go to "Bid Items” @To AWP Precon XML From AWP XML
e [% Checked By ] Rebuild References O Round Up Quantity AE,‘ Order MQ Sheets  [= Generate Cost Report

Project Data MQ Sheet Tool Export Import Help ~

Figure 3.1 “Published Bid Items” command.

All Published Bid Items

Refltem Name: - Filter 14 4|1 of 3427 » ¥
RefltemNam SpecBook  Description ShortDesc  Unit CreatedDT LastUpdatec IsObsolete ObsoleteDT Refliemld

W 03 Incentive/... | Inc/Dis for .. |CD 10142201 6192017 | [] 12345

108.4300 03 RBC Progr... RBC Progr... | EACH 10/14/201... | 10/14/201... l:‘ 6710
108.4400 03 CPM Progr... CPM Progr... | EACH 10/14/207... | 61472017 .. l:‘ 6534
201.0105 03 Clearing Clearing STA 10/14/201... | 10/14/201... l:‘ 6535
201.0110 03 Clearing Clearing SY 10/14/201... | 10/14/201... l:‘ 6536
201.0115 03 Clearing Clearing ACRE 10/14/201... | 10/14/201... |:| 6537
201.0120 03 Clearing Clearing ID 10/14/201... | 10/14/201... |:| 6538
201.0205 03 Grubbing Grubbing STA 10/14/201... | 10/14/201... |:| 6539
201.0210 03 Grubbing Grubbing SY 1014/201 . | 10/14/201 |:| 6540
2010215 03 Grubbing Grubbing ACRE 1014/201 . | 10/14/201 |:| 6541
201.0220 03 Grubbing Grubbing ID 1014/201 . | 10/14/201 |:| 6542

Figure 3.2 List of currently published bid items from AWP.
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3.2 Project Bid Items

Q2P > Data > Project Bid Items (Figure 3.3) will display the active workbook’s (a.k.a. project’s) list of bid
items. When a new Q2P project is started, the program creates a snapshot of the published bid items from
the AWP server to begin with. This Project Bid Items list (Figure 3.4) is also editable by the user to add or
delete user defined items. See section 7. Items with Supplemental Descriptions.

= 1234-56-78_mqw.xlsx - Excel &= O

File Home Insert Page layout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do \f, Share

Tj 41 Project Setup &] Published Bid Items  *=Create MQ Sheet =% Remove Bid ltem ) Update Bid Item(s) | [ To Estimator XML From Estimator XML > About
N [ Category Setup EZ’ Project Bid Items =] Rename MQ Sheet (EE Insert Bid Item(s) 5 Go to "Bid Items” @,To AWP Precon XML @—‘, From AWP XML
= [# Checked By E Rebuild References O Round Up Quantity AB: Order MQ Sheets [ Generate Cost Report

Project Data MQ Sheet Tool Export Import Help ~

Figure 3.3 “Project Bid Items” command.

Project Bid Items [File Created:5/14/2019, Last Updated from AWP:5/14/2019] O X
Filter: All LB of 2428 | » M |4k | No Bid ltem changes
IsSelected  RefltemNam Description  ShortDesc ggzﬂﬁ’:dsc' gg’;{}’:ﬁ)’gﬁ:ﬁ Uit CreatedDT LastUpdatec IsObsolete  Obsole,” [ EditMode
» 108.3100.S | Incentivel... | Inc/Dis for .. ] cD 10/14/201... | 6/19/2017 ... ]
| 1084300  RBC Progr.. RBC Progr... O EACH 10/14/201... | 10/14/201... O Bid Items Detail
| 1084400 | CPM Progr_. CPM Progr. M EACH 10/14/201.. | 8/14/2017 .. M e s .
] 2010105  Clearing Clearing O STA 10/14/201... | 10/14/201... ]
] 2010110 Clearing Clearing O sY 10/14/201... | 10/14/201... ] TS
| 2010115 Clearing Clearing O ACRE 10/14/201... | 10/14/201... [l
| 2010120 Clearing Clearing M D 10/14/201.. | 10/14/201... M
Description:  Incentive/Disincentive for Interim Com
] 2010205  Grubbing  Grubbing O STA 10/14/201... | 10/14/201... ]
] 2010210 | Grubbing | Grubbing O sY 10/14/201... | 10/14/201... ]
| 2010215  Grubbing  Grubbing O ACRE 10/14/201... | 10/14/201... [l ShortDesc:  Inc/Dis for Interim Completion of Work
| 2010220  Grubbing  Grubbing O D 10/14/201... | 10/14/201... [l
| 202.0105  Roadside .. Roadside . M STA 10/14/201.. | 10/14/201... M Unit: |CD 5
] 2020110 | Roadside .  Roadside . O sY 10/14/201... | 10/14/201... ]
] 2020115 Roadside ... |Roadside ... ] ACRE 10114/201.. | 10114/201.. 1] Supplement Description Required:
| 2030100  Removing ... Removing ... O EACH 10/14/201... | 10/14/201... [l
| 2030200  Removing .. Removing . LS 10/14/201.. | 10/14/201... M Supplemental Description (Please use mixed case):
] 203020001 Removing . Removing 01.TBD  |[LS 5/14/2019 _  5/14/2019 [
] 20302105 | Abatemen.. Abatemen. LS 10/14/201... | 10/14/201... ]
] 203.0210...  Abatemen...  Abatemen.. 01.TBD  [LS 5/14/2019 ... 5/14/2019 .. []
| 203.0215.5  Abatemen... Abatemen... O Ls 11/20/201... | 11/20/201... [l E -
| 203.0225.5 | Debris Co... | Debris Co... LS 10/14/201.. | 10/14/201... M
] 2030225 Debris o | Debris Co. 01.TBD  [LS 5/14/2019 5142010 ]
] 20305005 Removing . RemOldS. Ls 1014/201 | 1014/201 ]
] 203.0500... Removing... RemOIdS.. 01.TBD  [LS 5/14/2019 ... 5/14/2019 .. ]
] 203.0600.5 Removing... Rem OldS.. LS 10/14/201... | 10/14/201... ]
] 2030600 Removing . RemOldS. 01.TBD  |[LS 5/14/2019 _  5/14/2019 [
] 20307005 Removing . RemOldS. Ls 1014/201 | 1014/201 ]
[l 2020700 | Damminn | Dam aid N TRn e crannia enannia [l v
< >

Figure 3.4 List of currently Published Bid Items from AWP.
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3.3 Updating and Reconciling the Standard Bid Item List

Most projects will not be designed in less than a year which requires the need to contend with WisDOT’s
yearly updates to its Standard Specification list of bid items and Standardized Special Provision items.
Although users are unable to manually add or delete standard bid items, Q2P does have a Reconciliation Tool
available (Figure 3.5) to compare the list of bid items in the Q2P workbook with the current master list of bid
items on the AWP database server. This tool also allows users to update their Project Bid Item list with any
new bid items from year to year.

Q2P will attempt to query the AWP database to pull the current bid item master list each time the user opens
Q2P from a new Excel session. Alternatively, the user can force an update to the Project Bid Item list by
pressing the Published Bid Items button in the Q2P ribbon. Both methods require an active internet
connection.

To check for any bid item changes:

1. Select Q2P > Data > Project Bid Items. If there are any changes, users will notice a string of red text
(Figure 3.5) next to the blue “+” in the “Project Bid Items” dialog box.

1
‘ Click to reconcile Bid Items data update

Figure 3.5 Reconciliation Tool in “Project Bid Items” dialog box.

2. Click on the red colored text to bring up the “Reconcile Project Bid Items with Published Bid Items”
dialog box (Figure 3.6).
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Reconcile Project Bid Items with Published Bid Items X

New
Bid Items in this Project but not in the Published:

RefltemNam Description

ShortDesc  Unit CreatedDT  LastUpdatec IsObsolete  ObsoleteDT SuppDescrR Refltemid IsSelected

SpecBook

“~Add to Project™
New Bid ltems in the Published but not in this Project: e

RefltemNam Description ShortDesc  Unit CreatedDT  LastUpdatec IsObsolete  ObsoleteDT SuppDescrR Refltemld  SpecBook
] 211.0600.S |Prepare Cl... |Prep CIR ...

211.0700.S |Prepare F... |Prep Fdnf.. |EACH 6/4/20198... 6/4/2019 8... ] 14124 03
211.0800.S |Base Rep... |Base Rep.. |CY 6/4/20198... 6/4/2019 8... [] 14125 03
327.1000.S |CIR Aspha...|CIR Aspha... | SY 6/4/20198... 6/4/20199... [] 14126 03
455.0770.S |Asphalt St.. |Asphalt St.. |TON 6/4/20198... | 6/4/2019 8. ] ] 14127 03
502.9000.S |Underwate...|Underwate...| EACH 6/3/20193... | 6/3/2019 3. ] 14121 03
606.9105.S |Underwate... | Udrwir Su... |LF 6/3/20193... | 6/3/2019 3. ]

Change

Bid ltems in this Project need update: e Bid ltems in the Published have change(s): e

RefltemNam Description ShortDesc  Unit CreatedDT  Las!
[ 615.1000 | wisconsin ... | wisconsin ... |LS 10/14/201...

RefltemNam Description ShortDesc  Unit CreatedDT

Highlight
Differences

Figure 3.6  Reconciliation Tool in “Project Bid Items” dialog box.

3. Review the “Reconcile Project Bid Items with Published Bid Items” dialog box to view each specific item
change.

A. Bid Items in this Project but not in the Published: This section displays standard items that are
contained in your Q2P file, but are not housed within the AWP list. This section is normally blank,
but an item showing up in this window could indicate that an item has been removed from the AWP
master list that your Q2P file still utilizes. This section is for informational purpose only.

B. New Bid Items in the Published but not in this Project: This section displays any new bid items that
were added to the AWP master list that did not exist when your Q2P file was created. Typically, these
are the new items from a yearly Specification update. If you want to add these bid items to your
current Q2P projects bid item list, select the item(s) you want to add, then click on the “AAdd to
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Project™” button located just above this section. This will insert the new specification bid items to
your Q2P project bid items list so you can create the associated MQ sheets.

Z* If a new bid item is added that requires a supplemental description, you will also need
to create a new bid item as outlined in section 7.1 Add a New Item to the Project Bid

Items List prior to creating an MQ sheet or adding it to an existing MQ sheet.

C. BidItemsin this Project need update: & Bid Items in the Published have changes: These two sections
display any changes to previously existing bid items numbers. This could include description changes,
unit of measurement changes, or items being marked as obsolete.

Change
Bid ltems in this Project need update: Bid Items in the Published have change(s):

RefltemNam Description  ShortDesc  Unit CreatedDT  Las RefltemNam Description  ShortDesc  Unit CreatedDT

.515,1(](][] Wisconsin .. |Wisconsin . |LS 10/14/201... [10/14 -515,10(][] Wisconsin . Wisconsin ... EACH 10/14/201...
Highlight
Differences
Accept
Changes
< > < >

Figure 3.7 “Change” section of the Reconciliation Tool with highlighted differences selected.

The section on the Left-hand side displays the bid item information as it is currently in your Q2P file.
The section on the Right-hand side displays the bid item information as it is currently in the AWP
database. Clicking on the “Highlight Differences” button will highlight what has changed (Figure 3.7).
The columns in this window are expandable to make it easier to read the entire descriptions of bid
items. Once the changes are highlighted, you can decide if you want to click on “Accept Changes” to
update the Q2P file. This will make your Q2P file match the information in AWP.

2 Prior to accepting any changes, check to see if you have MQ sheets created for any of the updated

items. The descriptions, supplemental descriptions and unit of measure are not dynamically

linked to the MQ sheet. Therefore, you will need to manually update these fields on your MQ
sheet.

vk If the item being updated requires a supplemental description, then any Q2P pre-
made “.01” items need to be manually updated following the procedure in section 7.1
Add a New Item to the Project Bid Items List. Alternatively, if the item requires a

supplemental description, and the change was to the unit of measure or description,
the Q2P existing pre-made “.01” item will need to be deleted. Then a new “.01” item
will need to be added to the Project Bid Items list using the recently changed bid item
as a base.
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4. Contingency Amounts

: Do not include construction contingencies in the Delivery Cost field in Q2P, and do not keep
contingencies in the final estimate.

In Q2P, users can add a transient, mock bid item for contingencies for each category.

A separate contingency item is required for each category as the appropriate percentage will vary. Multiple
items per each category can also be used, if separating the costs is desired (e.g. Traffic Control and Drainage
both in Cat. 0010).

Delivery cost is different than contingency amounts used in preliminary cost estimates; it is an estimate of
staffing costs during the construction phase of a project. Prior to final submittal of the cost estimate, this
value should be coordinated with the delivery cost/percentage in FIIPS for the project.

To add contingencies, utilize a Lump Sum (LS) SPV item and see section 7. Items with Supplemental

Descriptions.
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5. Adding Bid Items and MQ Sheets
From the MQ Sheet section of the Q2P ribbon, Q2P > MQ Sheet > Create MQ Sheet (Figure 5.1) will
bring up the dialog box to add the item/s and create the miscellaneous quantity (MQ) sheet/s in one
step. If multiple bid items are created on one MQ sheet, that is known as a “summary sheet.”

= s 1234-56-78_mqw.xlsx - Excel

File Home Insert Page layout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do & Share

Tj 4jProject Setup &Z] Published Bid Items | *= Create MQ Sheet |=% Remove Bid Item &) Update Bid Item(s) @,To Estimator XML @—‘, From Estimator XML &5 About
N [Z4 Category Setup F,: Project Bid Items =] Rename MQ Sheet «j{ Insert Bid Item(s) 5~ Go to "Bid ltems” EE)TO AWP Precon XML From AWP XML
= [# Checked By E Rebuild References O Round Up Quantity AB: Order MQ Sheets [ Generate Cost Report

Project Data MQ Sheet Tool Export Import Help ~
Figure 5.1 “Create MQ Sheet” command.

1. Once the “Create MQ Sheet...” dialog box appears (Figure 5.2), select the desired items and the
appropriate categories to be associated with those items. You can type part of the item description in
the search bar to navigate to a particular item in the list, but be aware that Q2P is unable to search within
supplemental descriptions. Select multiple items/categories by holding either the “Shift” or “Ctrl” keys
and clicking different items, or by clicking and dragging across your selection. To completely reset the
selection, use either the “Reset Bid Items Selection” or the “Reset Categories Selection” buttons.

Use of the Shift key allows for the selection of all items between the two selected; use
of the Ctrl key allows for discrete selection and de-selection with every click.

: Use caution when holding the “Crtl” key to select multiple items. If you accidentally release the
“Crtl” key while selecting an additional item, all previously selected items in the list will no longer

be selected.

Create MQ Sheet... X
Select the items below to create MQ sheets: Reset Bid ltems Selection
108.3100.5 Incentive/Disincentive for Interim Completion of Work [CD] U d e ST
1084300 RBC Progress Schedule [EACH] Find Next
108.4400 CPM Progress Schedule [EACH]
201.0105 Clearing [STA]
201.0110 Clearing [SY] New Misc. QTY Sheet
2010115 Clearing [ACRE] .
2010120 Clearing [ID] Selected Bid ltems
201.0205 Giubbing [STA]
2010210 Grubbing [SY]
201.0215 Girubbing [ACRE]
2010220 Grubbing [ID]
202.0105 Roadside Clearing [STA]
2020110 Roadside Clearing [SY]
2020115 Roadside Clearing [ACRE] .
203.0100 Removing Small Pipe Culverts [EACH] SRR
203.0200.01 Removing Old Structure (station) (01. TBD) [LS]
203.0210.8.01  Abatement of Asbestos Containing Material (structure) (01. TBD) [LS]
203.02158 Abatement of Asbestos Containing Material [LS]
203.02258.01  Debrs Containment (structure) (01. TBD) [LS]
203.0500.5.01  Removing Old Structure Over Waterway (station) (01. TBD) [LS]

203.0600.8.01  Removing Old Structure Over Waterway With Minimal Debris (station) (01. TED) v

New MQ Sheet name
Select the categories to be used: | Reset Categori lecti | |
0010 | 05 - 4R Maintenance, Resurfacing (Roadway Construction) | 80% Federal 20% State
0020 | 10 - Bridge Replacement (Bridge Replacement B-XX-XXX) | 75% Federal 25% City of Green Ba
0030 | 03 - Reconstruction, Added Capacity (Retaining Walls) | 25% Federal 75% City of Green Bay
Create Separate Sheets

Figure 5.2 “Create MQ Sheet...” dialog box.
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2. Tofinish, select “Create New Sheet” to put all selected bid items on one summary sheet, or select “Create
Separate Sheets” to create separate individual MQ sheets for each bid item.

If creating a summary sheet, remember to name the sheet with a numerical prefix so

ZX
that it is inserted in the order of your preference. (i.e. 202-Clearing and Grubbing)

2 If an MQ sheet is created in error, using the Excel undo/redo is not recommended. If an MQ sheet
must be deleted after it is created, use the Q2P Remove Bid Item command.

Occasionally the Excel worksheets will get out of numeric order when creating new MQ sheets. Use Q2P
> Tool > Order MQ Sheets (Figure 5.3) to reorder the worksheets.

= s 1234-56-78_mgw.xlsx - Excel

File Home Insert Page layout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do |~ Share

N [ Category Setup | [ Project Bid Items =l Rename MQ Sheet €= Insert Bid Item(s) = Go to "Bid Items” ] To AWP Precon XML  [=]3 From AWP XML
W [# Checked By E Rebuild References O Round Up Quantity AB: Order MQ Sheets | [ Generate Cost Report

Project Data MQ Sheet Tool Export Import Help ~

Tj 41 Project Setup &]Published Bid Items = *= Create MQ Sheet =% Remove Bid [tem &) Update Bid Item(s) [ To Estimator XML From Estimator XML &5 About

Figure 5.3 “Order MQ Sheets” command.
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6. Adding/Deleting Categories

Users can easily add additional categories and delete unwanted categories from existing MQ sheets using

the following workflows.

6.1 Add Categories

Before adding additional categories to an existing MQ sheet, confirm that those additional categories have
already been set up via step 4 of section 2. Begin a New Project. To add additional categories to an existing
MQ sheet:

Qzp

VgProject Setup & Published Bid Items  *= Create MQ Sheet 3 Remove Bid Item @) Update Bid Item(s) <} To Estimator XML [+ From Estimator XML &3 About
[ Category Setup [ Project Bid ltems_ %I Rename MQ Sheet €= Insert Bid 5 Go to "Bid Items” | [} To AWP Precon XML  [-3§ From AWP XML

Rl £ Checked By e 5 Rebuild References () Round Up Aﬂo:dumshms [&) Generate Cost Report

Project Data MQ Sheet Tool Export Import Help ~
(TOTAL646.6020_0020 v) o * v  fr | =SUM(K15:K19) v
4 A BECDEF G Kk I ) K L M o l » |l @ | & | s | ¥ ~
1] Pavement Marking
2]
3
4 646.1020 646.6020 646.6220

Marking Line  Marking Stop Line  Marking Yield Line
5| Epoxy &-inch  Epoxy 12-inch Epoxy 18-inch
g“ CATEGORY STATION TO STATION __ LOCATION iF iF EACH REMARKS
8| 0010 20000 - 200450  LT&RT 100 -
9 | 0010 200050 - 200460 LT&RT - - 80
10| o010 201450 - 201460 LT&RT - 40 =
11| 0010 201460 - 211460 AT 1,000 -
12
13 TOTAL 0010 1,100 ™) 80
14
15 200400 - 200450 LT&RT 100 -
1‘- 200450 - 200+60 LT & RT = = 80
17: 201450 - 201+60 LT & RT o 40 =
1§ 201+60 - 211+60 RT 1,000 - -
19
@ TOTA0020) 1,100 40 20
5 -
23 —
« » .| 506-Structure | 517-Structures2 | _646-Pavement Marking | 6463020 | SF.. ) | «| |

Ry 13 Bloo-—+ —+m

Figure 6.1 Adding a category to an existing MQ sheet.

1. Copy and paste the text and formatting of a category name and total that is already on the MQ
sheet or summary sheet and place them in the same columns.

2. Change the text to the desired category.

3. Select Q2P > MQ Sheet > Rebuild References to bring up the “Rebuilding reference in MQ Sheet”
dialog box (Figure 6.2) and select “Start Rebuilding” to create the proper named ranges for the
bid item total(s).
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Rebuilding Reference in MQ Sheet s
Start Rebuilding

Defined - '646-Pavement Marking'!TOTALE46.1020_0020 ~

Defined - 'é46-Pavement Marking'!TOTALE46.6020_0020

Defined - 'é46-Pavement Marking'!TOTALE46.6220_0020

>>>Rebuild References completed!

Figure 6.2 “Rebuilding reference in MQ Sheet” dialog box after references have been built.

4. Select Q2P > Tool > Go to “Bid Items” or use the right-click menu to navigate back to the main
“Bid Items” worksheet.

5. Use Q2P > Tool > Update Bid Items(s) and select “Update All in this Worksheet”. Select “Yes” to
confirm and refresh the links to the “Bid Items” worksheet. Click “OK” to close the dialog box and

see the reflected changes (Figure 6.3).

646.1020 Marking Line Epoxy 4-Inch 2200 LF

Marking Stop Line Epoxy 12-Inch | 80 LF
Marking Yield Line Epoxy 18-Inch 160 EACH

Figure 6.3 Updated bid item quantities after adding another category.
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6.2 Delete Categories from Project

2 Only the last category (max. category number) can be deleted from Category Setup. Before
proceeding, verify that the category to be deleted is not being used in any MQ Sheet.

To delete a category (e.g. Category 0030) out of the entire project or from the “Bid Items” worksheet:

g Project Setup !amﬂm *= Create MQ Sheet 3% Remove Bid ltem € Update Bid Item(s) Btmm (7 From Estimator XML &5 About
L% Category Setup  [7 Project Bid tems =] Rename MQ Sheet €= Insert Bid ltem(s) 5" Go to "Bid Items™  [<}To AWP Precon XML 7] From AWP XML
(%} Checked By | [ Rebuild References )" Round Up Quantity A Order MQ Sheets [ Generate Cost Report

Setup Category, Federal Work Type & Category Description...

Category: e Federal Work Type:
|003€) 7‘ |03 - Reconstruction, Added Capacity

Category Description

|Rela\mng Walls

Funding:
|25% Federal 75% City of Green Bay

K_TYPES AND (CATEGORY DESCRIPTION) F U (R 2
05 - 4R Maintenance, Resurfacing (Roadway Construction) 80% Federal 20% State $35,770.00
10 - Bridge Replacement (Bridge Replacement B-XX-XXX) 75% Federal 25% City o $12,200.00
03 - Reconstruction, Added Capacity (Retaining walls) 25% Federal 75% City o $280.00

143 o

Figure 6.4 Category Setup window.

1. Use Q2P < Project < Category Setup to bring up the “Setup Category, Federal Work Type &
Category Description...” dialog box.

2. Select the last existing category (Category 0030 in this case) from the “Category” drop-down.

3. Select “Delete” to finish and close the dialog box.

The row previously containing the deleted category should be cleared as in Figure 6.5.

75

76

77 | CATEGORIES FEDERAL WORK TYPES AND (CATEGORY DESCRIPTION) FUNDING (REFER TO FIIPS)

78 | 0010 05 - 4R Maintenance, Resurfacing (Roadway Construction) 80% Federal 20% State $35,770.00 ||

79 | 0020 10 - Bridge Replacement (Bridge Replacement B-XX-XXX) 75% Federal 25% City o $12,200.00

80

81 | —
» Bid Items | 201-Clearing and Grubbing | 203.0200.01 | 204-Removals | 208 ... (¥ 4| | »

Ready Filter Mode %) H m - ' | + 90%

Figure 6.5 Category 0030 is no longer visible in the list of categories.

2 If a category is listed on an MQ sheet, but not defined on the “Bid Items” worksheet, Q2P will not
recognize any totals for that category and they will not appear in the Cost Report or the XML files
to Estimator or AWP.
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6.3 Delete Categories from MQ Sheets

Delete unneeded category rows (using Excel commands) from the individual MQ sheets. Do not keep
empty Cat. 0020, 0030 totals on the MQ sheet or summary sheet (unless intended to be used at a later

time.) To delete unneeded categories from an existing MQ sheet:

+7 lgProjectSetup G Published Bid Items *= Create MQ Sheet > Remove Bid It &P  Update Bid Item(s) [€}To Estimator XML [57] From Estimator XML &5
{3 Category Setup  [37 Project Bid Items __ =i Rename MQ Sheet €= Insert Bid Item({ff;) 5~ Go to "Bid Items™ | [£}To AWP Precon XML (] From AWP XML
(23 Checked By e i Rebuild References ()" Round Up Quantity’ A Order MQ Sheets [& Generate Cost Report
Project Data MQ Sheet Tool Export Import Help A
A15 v Je | 'o020 v
A EBE C€C Dl E G H | J K L M N 0 P Q R S T -
1 Pavement Marking
2
3
4 646.1020 646.6020 646.5220
Marking Line  Marking Stop Line  Marking Yield Line
5 Epoxy 4-Inch Epoxy 12-Inch Epoxy 18-Inch
6 |CATEGORY STATION TO STATION  LOCATION LF LF EACH REMARKS
7
8 0010 200400 - 200+50 LT & RT 100 -
9 0010 200450 - 200+60 LT & RT - - 80
10| oo10 201+50 - 201+60 LT &RT - 40 -
11| oo10 201+60 - 211460 RT 1,000 - - Calibri Li ~/8 - At AT ~ o 9
12 i A A S % ;
13 TOTAL 0010 1,100 40 30 BIEo- A 5050
14
15| o020 200¢00 - 200+50 LT &RT 100 = E
16| o020 200450 - 200+60 LT &RT - = 80 X Cut
17| o020 201+50 - 201+60 LT &RT - 40 = S
18| 0020 201460 - 211+60 RT 1,000 - - 8 Copy
19 “D Paste Options:
20 TOTAL 0020 1,100 40 80 -
21
22 0O
23 Paste Special...
24
25 Insert
gg e Delete
28 Clear Contents
29
g? Format Cells...
32 Row Height...
Z . Hide ! -
4 » .. 465-Asphalt Pavement 506-Structure 517-Structures 2 | 646-Pavement ... (3) 4 - »
— - Unhid
Ready 29 Average: 10948.66667 Count: 36 L. ‘__r“gle R B 5] P ' | + 100%

Figure 6.6 Deleting a category from an existing MQ sheet.

1. Select the rows of cells of the category to delete by clicking and dragging over the row numbers
(for example, rows 15-20 in Figure 6.6).

2. Right click on the selection and click “Delete”.

3. Use Q2P > MQ Sheet > Rebuild References and select “Start Rebuilding” to refresh the named
ranges for the bid item total(s).

4. Use Q2P > Tool > Update Bid Items(s) and select “Update All in this Worksheet”. Select “Yes” to
confirm and refresh the links to the “Bid Items” worksheet. Click “OK” to close the dialog box.

5. Use Q2P > Tool > Go to “Bid Items” or use the right-click menu to navigate back to the main “Bid
Iltems” worksheet to see the reflected changes (Figure 6.7).
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X 646.1020 Marking Line Epoxy 4-Inch 1100 LF $10.00 $11,000.00

646.6020 Marking stop 'ine Epoxy 12-Inch
646.6220 Marking Yield Line Epoxy 18-Inch

Figure 6.7 Updated bid item quantities after deleting unneeded category.
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7. Items with Supplemental Descriptions
Items that contain ( ) in their ITEM DESCRIPTION and SPV items are required to have a supplemental
description entered, and a unique bid item number assigned. This is true for any item that has extra digits
appended to the item number — item numbers must be unique if they are intended to pay for different things
within the contract.

: For these special items in Q2P, the bid item numbers must be set up properly in the Project Bid
Items list PRIOR to creating the item MQ sheets.

For contracts with multiple projects, remember that items that need a supplemental description, such as
“Finishing Roadway (project),” need unique numbers for each project, for example:

Finishing Roadway (01. 1234-56-78); Finishing Roadway (02. 9999-99-79)
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7.1 Add a New Item to the Project Bid Items List Using the “Project Bid Items” Dialog Box

2 Be aware that this only inserts a new item into this project’s Project Bid Items list, and either the
associated MQ sheet needs to be created via workflow 5. Adding Bid Items and MQ Sheets, or this

item needs to be added to an existing MQ sheet via workflow 8.2 Inserting a Bid Item into an
Existing MQ Sheet.

Project Bid Items [File Created:5/14/2019, Last Updated from AWP:5/14/2019]

' Filter: Al v 42428 of 2428 e* No Bid Item changes

SuppDescr  Supplement:
Required Description

01.TBD SACK 5/14/2019 . |5/14/2019
sD 10/14/201_ | 10/14/201
SPV.0160._.. | Special Spegcial 01.TBD sD 5/14/2019 __ |5/14/2019
SPV.0165 | Special Special SF 10/14/201... | 10/14/201...
SPV.0165.... | Special Special 01.TBD SF 5/14/2019 ... | 5/14/2019 ...
SPV.0170 | Special Special STA 10/14/201_ | 10/14/201
SPV.0170.__. | Special Special 01.TBD STA 5/14/2019 _ |5/14/2019
SPV.0175 | Special Spegcial 10/14/201_ | 10/14/201
SPV.0175_. | Special Spegcial 01.TBD 5/14/2019 . |5/14/2019
SPV.0180 | Special Spegcial 10/14/201_ | 10/14/201
SPV.0180.... | Special Special v 01.TBD 5/14/2019 ... | 5/14/2019 ...
SPV.0185 | Special Special 10/14/201... | 10/14/201...
SPV.0185__ | Special Special 01.TBD 5/14/2019 _ |5/14/2019
SPV.0187 | Special Special 10/14/201_ | 10/14/201
SPV.0187 . | Special Spegcial 01.TBD 5/14/2019 . |5/14/2019
SPV.0190 | Special Spegcial 10/14/201_ | 10/14/201
SPV.0180__. | Special Spegcial v 01.TBD 5/14/2019 __ |5/14/2019
SPV.0195 | Special Special 10/14/201... | 10/14/201...
SPV.0195.... | Special Special 01.TBD 5/14/2019 ... | 5/14/2019 ...
SPV.0200 | Special Special 10/14/201_ | 10/14/201
SPV.0200.... | Special Special 01.TBD 5/14/2019 _ |5/14/2019
SPV.0205 | Special Spegcial 10/14/201_ | 10/14/201
SPV.0205.... | Special Special 01.TBD 5/14/2019 | 5/14/2019
SPV.0210 | Special Spegcial v 10/14/201_ | 10/14/201
SPV.0210.... | Special Special 01.TBD 5/14/2019 ... | 5/14/2019 ...
SPV.0215 | Special Special 10/14/201... | 10/14/201...

, _:-203,0200,05 Removing .. | Removing... 05.

<

i
IsSelected  RefltemNam Description =~ ShortDesc Unit CreatedDT  LastUpdatec IsObsolete  Obsole E dit Mode

SPV.0155....  Special Special
SPV.0180  Special Special

Bid Iltems Detail

Refltem Name: |203.0200.05 e

Description: ‘Remwng 0Old Structure (station) |

<

NININN

Short Desc: |Removing Old (staton) |

NN NSNS

Unit. LS

Supplement Description Required:

Supplemental Description (Please use mixed case):

[05.STA 5+00]

NN

NN

I 1 o o

J1O000000000000000000000Oo0ooon

]

Figure 7.1 “Project Bid Items” dialog box.

1. Select Q2P > Data > Project Bid Items to bring up the “Project Bid Items” dialog box.
2. Select the blue “+” button to add a new item to the bottom of the list.

3. Make sure the “Edit Mode” box is checked.
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4. Select a base bid item to modify.

X

%

If you are adding a single iteration of an item requiring a supplemental description,
Q2P includes pre-made “.01” versions of such items for the user to simply select from
the list and modify. (See Figure 7.2)

The .S items that do not require a supplemental description are only used once and
therefore, can be selected directly from the list when creating MQ sheets. Note how
these .S items have a blank field in the “Supplemental Description” column. (See
Figure 7.2)

2040230

Non-Editable Base Item Pre-Made Editable
Supplemental Description

ing Building ... | R ing Building (station)

204.0230.01 ing Building ... |R ing Building (station)

204.0235

ing Building... ing Buildings (parcel)

204023501 ing Building..  Removing Buildings (parcel)

204.0240

Site Clearance (par... Site Clearance (parcel)

204.0240.01 | Site Clearance (par... Site Clearance (parcel)

204.0245

R ing Storm S... |R ing Storm Sewer (size)

]
|
a
O
]
]
|
|

204024501 R ing Storm S_.. |R ing Storm Sewer (size)

204.0201.8 / ing Sewer | A ing Sewer

EN|ENIENIEN| N[N RSN

(Does not require supplemental description)

20490018 moving Advanc... |Remov Adv Flasher A

20490025 moving Advanc... |Remov Adv Flasher A

20490255 | F ing (item de... | Removing (item di

2049025501 || ing (item de | Removing (item d

20490355 ing (item de... Removing (item

204.9035.5.01 ing (item de... ing (item

204.9060.5 ing (item de.. ing (item

204 90605 01 || ing (item de_ || ing (item d

20490705 | ing (item de | F ing (item

I

204.9070.5.01 ing (item de... Removing (item

KN N

Figure 7.2 Examples of special items. (SPV items included, but not shown)

5. Add the desired supplemental numerical suffix with (typically) two digits.

X

The item number suffix can and typically restarts at 01 for each different bid item.
The numbers do not need to be sequential, and in some cases, it is beneficial to leave
a gap in numbering, especially for when multiple items will be defined in a single
special provision, so additional sizes, types, etc. can later be easily added and grouped
with like items. (See Figure 7.3)

6. Add the desired supplemental description using the XX. Description format.
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7. Select “Update” to add the item to the “Project Bid Items” list for future use.

When editing the SPV item descriptions, the word “Special” is retained even though
it would not be in the special provision language. (See Figure 7.3)

SCHEDULE OF BID ITEMS WISDOT STANDARD SPECIFICATIONS

TOTAL BID ITEMS

10 = ITEM DESCRIPTION - QUANTITY ~ UNIT ~ UNIT PRICE ~ COST =
203.0200.01 Removing Old Structure (station) (01. 100+00) 0Ls $0.00
415.1150.5.01 Concrete Pavement Fast Track (inch) (01. 72-Inch) 0 sy $0.00
646.6464 Cold weather Marking Epoxy 4-Inch 0 LF $0.00
SPVv.0035.04 Special (04. Pavement Marking Epoxy 4-Inch) 0cy $0.00
sPv.0035.08 special (08. Pavement Marking Epoxy 8-Inch) 0cy $0.00
sPv.0035.12 Special (12. Pavement Marking Epoxy 12-Inch) 0cy $0.00
SPV.0035.50 special (50. Gravel) 0cy $0.00
SPv.0195.01 Special (01. Lukewarm Mix Asphalt Pavement Type Q-42) 0 TON $0.00
SPv.0195.02 Special (02. Cool Mix Asphalt Pavement Type 1) 0 TON $0.00
sPv.0210.01 Special (01. surveillance of ATt Route) 0 wK $0.00

Figure 7.3 Sample list of supplemental descriptions after creating MQ sheets.

More information on naming ( ) and SPV items can be found in FDM 19-15-80 and FDM 19-15-85.
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7.2 Editing of Supplemental Descriptions After Creation

A The “Bid Items” worksheet and the MQ sheets are not dynamically linked for the description text.

The bid item description on the MQ sheet is just a copy of the bid item description and
supplemental description text. Any changes by the user to the supplemental description via the
Project Bid Items list will need to be manually updated on the MQ sheet. This allows the user to
customize the MQ sheet headers without breaking any links or having their edits overwritten
when the Update Bid Item(s) command is used. All the data in Q2P is refenced by bid item
number, so when a sheet is created, all data is tied to that number and the user changing that
number would remove the connection to that data.

Project Bid Items [File Created:5/14/2019, Last Updated from AWP:5/14/2019]
' Filter: Al v 442428 of 2428 | » ¥l <k | No Bid Item changes

SuppDescr  Supplement:
Required Description

01.7BD SACK 5/14/2019 ... | 5/14/2019 ...
SD 10/14/201_ | 10/14/201
01.TBD sD 5/14/2019 . |5/14/2019
SF 10/14/201_ | 10/14/201
01.TBD SF 5/14/2019 __ |5/14/2019
STA 10/14/201_ | 10/14/201
01.TBD STA 5/14/2019 ... | 5/14/2019 ...
10/14/201... | 10/14/201...
01.TBD 5/14/2019 _ |5/14/2019
10/14/201_ | 10/14/201
01.TBD 5/14/2019 . |5/14/2019
10/14/201_ | 10/14/201
01.TBD 5/14/2019 | 5/14/2019
10/14/201... | 10/14/201...
01.TBD 5/14/2019 . |5/14/2019
10/14/201_ | 10/14/201
01.TBD 5/14/2019 . |5/14/2019
10/14/201_ | 10/14/201
01.TBD 5/14/2019 __ |5/14/2019
10/14/201_ | 10/14/201
01.TBD 5/14/2019 ... | 5/14/2019 ...
10/14/201_ | 10/14/201
01.TBD 5/14/2019 _ |5/14/2019
10/14/201_ | 10/14/201
01.TBD 5/14/2019 . |5/14/2019
10/14/201_ | 10/14/201

)
IsSelected  RefltemNam Description =~ ShortDesc Unit CreatedDT  LastUpdatec IsObsolete  Obsole E dit Mode

SPV.0155.... | Special Spedcial
SPV.0160  Special Special
SPV.0160.... Special Special
SPV.0185  Special Special
SPV.0165.... Special Spegial
SPV.0170  Special Spegial
SPV.0170.... | Special Special
SPV.0175 | Special Spedcial
SPV.0175....  Special Special
SPV.0180  Special Special
SPV.0180.... Special Special
SPV.0185  Special Spegial
SPV.0185... Special Spegcial
SPV.0187 | Special Special
SPV.0187._.. | Special Special
SPV.0190  Special Special
SPV.0180.... Special Special
SPV.0185  Special Special
SPV.0195... Special Spegial
SPV.0200  Special Spegcial
SPV.0200.... | Special Special
SPV.0205 | Special Special
SPV.0205.... Special Special
SPV.0210  Special Special
SPV.0210.... Special Special
SPV.0215  Special Spegial
203.0200.04 | Removing ... | Removing...

Bid Iltems Detail

Ref Item Name: |203.0200.04 o

Description: ‘ Removing Old (station) |

Short Desc: ‘Remw ing Old (station) |

Unit: LS

Supplement Description Required:

Supplemental Description (Please use mixed case):

|04 sTA 5+00]

04.STAS...

AR KRR EEE R R KRR R R KRR R R RIRIERE

10000000000 00000000 0OoOooooooad

O
a
a
a
|
|
]
O
a
a
a
|
|
]
O
a
a
a
|
0l
]
O
a
a
a
|
an

Figure 7.4 Edits made via “Project Bid Items” dialog box.
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1. Select Q2P > Data > Project Bid Items to bring up the Project Bid Items dialog box.

2. Select the bid item which requires editing the supplemental description.

3. Make sure the “Edit Mode” box is checked.

4. Make the desired changes to either the “Ref tem Name” number or the “Supplemental Description.”

5k If the item you are trying to edit is currently part of a MQ sheet, you will not be able
to edit the “Ref Item Name” field; only the “Supplemental Description” field. In order
to edit the “Ref Item Name,” you will need to remove that bid item from all MQ sheets
that contain that item. Use caution as this could delete any notes or quantity
information for this item that you may want to save.

5. Select “Update” to apply the changes.

2 If the numerical suffix of a user defined item needs to change (e.g. 203.0200.05 to 203.0200.04)
and the MQ sheet already exists for it, the Rename MQ, Sheet command must be run. Refer to
section 8.3 Renaming an MQ Sheet or Summary Sheet for more guidance on how to do this.
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8. Combining Multiple Bid Items into One Summary Sheet

8.1 Before You Combine Items

Before entering quantities into the MQ sheets, it is best to combine the like items into summary tables. This
is preferably done INITIALLY using workflow 5. Adding Bid Items and MQ Sheets and opting to add the items
onto a single MQ sheet (a.k.a. summary sheet), but this can also be done by inserting a bid item into an existing
MQ sheet using the following workflow in 8.2 Inserting a Bid Item into an Existing MQ Sheet.

It is good practice to set up all the item MQ sheets categories BEFORE combining them onto a summary sheet
because adding or deleting categories on the summary sheet requires links to be recreated. Run Q2P > MQ
Sheet > Rebuild References (Figure 8.1) whenever adding or deleting categories from an MQ sheet or
summary sheet to refresh or create the proper links. Run Q2P > Tool > Update Bid Item(s) (Figure 8.1) to
ensure the “Bid Items” worksheet is also refreshed.

[u] s 1234-56-78_maw.xlsx - Excel

File Home Insert Pagelayout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do & Share

Tj 4jProject Setup BZl Published Bid Items | *= Create MQ Sheet =% Remove Bid Item &) Update Bid Item(s) @,To Estimator XML @—‘, From Estimator XML &5 About
[ Category Setup Dj Project Bid Items =]| Rename MQ Sheet EE Insert Bid Item(s) = Go to "Bid ltems" EB,TO AWP Precon XML From AWP XML
[% Checked By ] Rebuild References |0 Round Up Quantity AE,‘ Order MQ Sheets  [= Generate Cost Report

Project Data MQ Sheet Tool Export Import Help ~

New

Figure 8.1 “Rebuild References” and “Update Bid Item(s)” commands.
: Q2P will track bid item totals that are shown in multiple sheets, so it is important to properly

delete any data that is no longer needed. Otherwise, bid item totals may be skewed for cost
estimating.

8.2 Inserting a Bid Item into an Existing MQ Sheet

1. Navigate to the existing MQ sheet via scrolling to the appropriate tab in Excel or use the right-click
menu while hovering on the desired bid item from the main Bid Items worksheet then select the sheet
you want to navigate to (Figure 8.2 and Figure 8.3).

Go to MQ sheet X
SCHEDULE OF BID ITEMS WISDOT STANDARD 646.1020 is included in the following MQ sheet(s):
TOTAL BID ITEMS
10 - ITEM DESCRIPTION - [ quantzm
203.0200.01 Removing 01d Structure (station) (01. 100+00)
415.1150.5.01 Concrete Pavement Fast Track (inch) (01. 72-Inch)
646.1020 |Marking Line Epoxy 4-Inch 1
646.3020 Marking Line Epoxy 8-Inch 57 Go to sheet(s) include "646.1020"
SPV.0035.04 Special (04. Pavement Markin Go
SPV.0035.08 Special (08. Pavement Mark"\n@ Quantity Link 4
SPV.0035.50 Special (50. Gravel)
sPV.0195.01 special (O1. Lukewarm mix as 30 Cut
SPV.0195.02 Special (02. Cool Mix Asphal E:“@ Copy
SPv.0210.01 special (01. surveillance of B
Figure 8.2 Right-Click menu. Figure 8.3 Go to MQ sheet dialog box. (Will display multiple

sheets if the item is found in multiple sheets.)

] You can also navigate back to the “Bid Items” worksheet via the “Return to “Bid
Items”” button in the right-click menu. See step 2 of Appendix B-2 Quick Navigation.
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2. From the MQ Sheet section of the Q2P ribbon, select Q2P > MQ Sheet > Insert Bid Item(s) (Figure
8.4).

= 1234-56-78_mqwaxlsx - Excel = — O

File Home Insert Page layout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do \ﬁ, Share

‘l'\j 4 Project Setup ©]Published Bid Items =~ *= Create MQ Sheet =% Remove Bid Item &) Update Bid Item(s) EB,TO Estimator XML From Estimator XML &5 About

@Categary Setup EZ’ Project Bid Items =] Rename MQ Sheet (EE Insert Bid Item(s) _)::Go to "Bid Items" @,To AWP Precon XML @—‘, From AWP XML

AT [% Checked By ﬁ@' Rebuild References ©- Round Up Quantity AE,‘ Order MQ Sheets [ Generate Cost Report

Project Data MQ Sheet Tool Export Import Help ~

Figure 8.4 “Insert Bid Item(s)” command.

3. Select the desired bid item(s) from the “Insert a Bid Item” dialog box (Figure 8.5) to add to the existing
MQ sheet and select “Insert” when finished.

Insert a Bid Item X
Select the Bid ltem(s) to insert into the project: Reset Bid ltems Selection
6465105 Marking Word Paint [EACH] ~ Item description search
6465120 Marking Word Epoxy [EACH] -
6465205 Marking Symbol Paint [EACH] [marking Find
6465220 Marking Symbol Epoxy [EACH]
646 5305 Marking Railroad Crossing Paint [EACH]
6465320 Marking Railroad Crossings Epoxy [EACH] Bid Item(s) to insert
646.5420 Marking Aenal Enforcement Bar Epoxy [EACH] Selected Bid ltem(s): 2
646.5520 Marking Outfall Epoxy [EACH]
646.6005 Marking Stop Line Paint 12-Inch [LF] 6466020, 646.6220
646.6020 Marking Stop Line Epoxy 12-Inch [LF]
646.6105 Marking Stop Line Paint 18-Inch [LF]
646.6120 Marking Stop Line Epoxy 18-Inch [LF]
646.6205 Marking Yield Line Paint 18-Inch [EACH]
646.6220 Marking Yield Line Epoxy 18-Inch [EACH]
646.6305 Marking Dotted Extension Paint 18-Inch [LF]
646.6320 Marking Dotted Extension Epoxy 18-Inch [LF]
646 6464 Cold Weather Marking Epoxy 4-Inch [LF]
646 6468 Cold Weather Marking Epoxy &-Inch [LF]
646.7005 Marking Diagonal Paint 6-Inch [LF]
646.7020 Marking Diagonal Epoxy 6-Inch [LF]
646.7105 Marking Diagonal Paint 12-Inch [LF] he

Figure 8.5 “Insert a Bid Item” dialog box.

4. Select “Insert” when finished to see the additional items. (See Figure 8.6 for resulting summary
sheet which needs to be renamed.)
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8.3 Renaming an MQ Sheet or Summary Sheet

If a summary sheet was not made from workflow 5. Adding Bid Items and MQ sheets and was made from
inserting additional bid items to an existing MQ sheet via workflow 8.2 Inserting a Bid Item into an Existing
MQ Sheet (Figure 8.6), you must rename the summary sheet. This tool also works on individual MQ sheets.

A B C D E F G H I J K L M N ] -
1] £46.1020
2
3
4 546.1020 646.6020 646.6220
Marking Line  Marking Stop Line  Marking Yield Line
5 | Epoxy 4-Inch Epoxy 12-Inch Epoxy 18-Inch
6 | CATEGORY STATION T0 STATION LOCATION LF LF EACH REMARKS
7
8 0010
9 0010
10| o010
11| oo1o0
12| oo1o0
13| oo10
14 | TOTAL 0010 0 0 [}
15 |
16 |
17 h
» ‘ Bid Items ‘ 203.0200.01 ‘ 415.11505.01€] 646.1020 106463020 | SPV.O(... (® ] »

Figure 8.6 Summary sheet created by inserting additional bid items and which needs to be renamed.

1. From the MQ Sheet section of the Q2P ribbon, select Q2P > MQ Sheet > Rename MQ Sheet (Figure
8.7).

= = 1234-56-78_mqw.xlsx - Excel

File Home Insert Page layout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do \5 Share

‘l'\j 4 Project Setup &1 Published Bid ltems *= Create MQ Sheet =% Rernove Bid Item &) Update Bid Item(s) EE)TO Estimator XML From Estimator XML L% About

[ Category Setup EZ’ Project Bid Items =] Rename MQ Sheet (EE Insert Bid Item(s) 5 Go to "Bid Items” @,To AWP Precon XML @—‘, From AWP XML
[% Checked By )" Round Up Quantity AB,‘ Order MQ Sheets [ Generate Cost Report

New

i1 Rebuild References C

Project Data MQ Sheet Tool Export Import Help ~

Figure 8.7 “Rename MQ Sheet” command.
2. Inthe “Rename MQ Sheet” dialog box, enter a name that starts with three numbers, then a hyphen,
and then a description that uses text and hyphens so the worksheet tab will be placed next to the
associated bid items (Figure 8.8).

Rename MQ Sheet X

Current Sheet Name: |ﬁ45_1020 |

New Sheet Name: |646—Pavement Marking| |

Figure 8.8 “Rename MQ Sheet” command.
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hyphens in the name).

3. Select “OK” to finish and see the changes (Figure 8.9).

Quantities 2 Plans User Guide

An Excel worksheet name cannot exceed 31 characters, be blank, or contain any of the following
characters\ /:? * []. AQ2P summary sheet is further limited to no special characters (other than

A B C | D | E il —G— Ll | J K L M N
1 | 646-Pavemeant Marking
2
3 o)
4 | 646.1020 646.6020 646.6220
Marking Line Marking Stop Line  Marking Yield Line
5 | Epoxy 4-Inch Epoxy 12-Inch Epoxy 18-Inch
6 | CATEGORY STATION T0 STATION LOCATION LF LF EACH RE
7
8 | oow
9 0010
10| o010
11 o010
12 0010
13| o010
14 TOTAL 0010 0 0 0
15 |
16 |
» Bid Items | 203.0200.01 | 415.1150.5.01 46-Pavement Marking ... (3 [ »
Figure 8.9 Renamed Summary sheet.
The title at the top middle of the summary sheet is initially generated through the
Z* renaming tool, but can be modified by the user. (Simply “Pavement Marking” vs.
“646-Pavement Marking”)
4. Onceitems have been combined onto a summary sheet, format your tables by adding the item names,
changing the title, centering, etc. and begin entering quantities into the table (Figure 8.10).
A B c E F G I J K L M N O Q R S T U VM W X Y
1 CONDUIT AND WIRE
2
3 : CONDUIT RIGID NONMETALLIC ELECTRICAL WIRE LIGHTING
4 652.0225  652.0235  652.0325  652.0335 | 655.0610 655.0620 655.0625 655.0630
SCHEDULE SCHEDULE SCHEDULE SCHEDULE
LINEAR 40 40 80 80
5 | DISTANCE 2-INCH 3-INCH 2-INCH 3-INCH 12 AWG 8 AWG 6 AWG 4 AWG
6 CATEGORY STATION STATION LF LF LF LF LF LF LF LF LF REMARKS
7] 240+80,57' LT - HH1 215 215 225 - - 13"
8 | o010 HH2-EX HH1-EX 35 - - 35 - 45 - 135 1#8; ADDS' EACH END
9 | HHI-EX Bl 165 165 - 175 - 525 -
10 81 B2 165 165 175 - 525 -
11 B2 B3 185 165 - - 175 - 525 -
12 | HH1 HH2 445 - 445 455 - - - 1-3"
13 HH2 HH7 430 - 450 1,000 - - 2-3"
14 K] HHE 520 255 - - 530 - - 1-2"
15 | HHE HH11 210 170 - 40 - - 220 860 1-2"
16 | HHY HH11 200 - 160 - 40 210 - - - 13"
17_ TOTAL 0010 920 1,055 75 40 2,185 790 660 1,710
18
19 |
20 | o020 45470 8L, 9'LT HH3 92 92 100 - - - 12"
21 | HH3 HH4 35 35 - 45 30 - 1-2"
22 | HH4 B4 150 150 160 320 - 2 #6; ADD 5' EACH END
23 | B4 HHE 120 120 - - 130 390 - 1-2"
24 | HH5 HH11 345 - 305 - 40 - - - 1-3" MUFN
25 | HHS - 453+21BL,15'RT 45 45 - 1-3" MFUN
26 | HH11 254+18, 29' LT 5 - 5 - - - - - - 1-3" MUFN
27 | TOTAL 0020 397 355 0 40 100 335 800 0
28
29i PROJECT TOTAL 1317 1410 75 80 2295 1125 1450 1710
30

4 »

646-Pavement Marking | 652-Conduit | 652-Conduit and Wire ‘ SP ...

®

Figure 8.10 Example of formatted table to be displayed on MQ Plan Sheets.

To add a missing category total to the existing MQ sheet, see section 6.1 Add Categories.
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Q2P can recognize when a bid item is already being used in another MQ sheet or summary sheet (Figure 8.11).
If you create a new MQ sheet that includes that used item, Q2P will automatically insert an asterisk at the top
of the bid item’s description in the newly created MQ sheet (Figure 8.12).

[652.0225 6520235
Schedule  Schedule
40 a0

3-Inch

Figure 8.11 Existing summary sheet with bid items 652.0225 and 652.0235.

[o] E F G

652-Conduit

[
>
-
n

CATEGORY STATION TO STATION LOCATION

652.0225 652.0235
Conduit Rigid  Conduit Rigid
Nonmetallic
Schedule 40 Schedule 40
2-Inch 3nch
LF LF

Nonmetallic

REMARKS

0010
0010
0010
0010
0010
0010
TOTAL 0010

BEBBIZ e

o
~ o

E(luantltles shown elsewhere in plan.)

[»]

L=
. O®

» .| 6463020 | 646-Pavement Marking | 652-Conduit | 652-Conduitar ... (%)

Figure 8.12 Newly generated summary sheet with bid items 652.0225 and 652.0235 & asterisk designation.

il

This asterisk is simple text, so users can either use this designation as is or they can modify it. Note that an
asterisk will not appear on the existing sheet that contains the original bid item and will need to be manually

added by the user.

In addition to the asterisk, for quantities shown on multiple sheets, users must include
¥k  a note such as “Quantities shown elsewhere in plan.”
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9. Deleting Bid Items and MQ sheets

The Remove Bid Item command (Figure 9.1) is used to delete both a bid item from one or more MQ sheets,
as well as delete the actual MQ sheet if it only contained the one bid item on it. At this time, Q2P is unable to
delete an entire summary sheet and each item on that summary sheet must be removed one by one.

= s 1234-56-78_mqw.xlsx - Excel

File Home Insert Page layout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do & Share

Tj 4jProject Setup BZ] Published Bid Items | *= Create MQ Sheet | =% Remove Bid Item &) Update Bid Item(s) @,To Estimator XML @—‘, From Estimator XML &5 About

ECategory Setup F,: Project Bid Items =]l Rename MQ Sheet € Insert Bid Item(s) _)==Go to "Bid Items” EB)TO AWP Precon XML From AWP XML

e [# Checked By E Rebuild References O Round Up Quantity AB: Order MQ Sheets [ Generate Cost Report

Project Data MQ Sheet Tool Export Import Help ~

Figure 9.1 “Remove Bid Item” command.
Before deleting a bid item, it is good practice to either save a copy of the Q2P

workbook, or to copy the appropriate rows/columns of data back to another
worksheet or workbook so that data is not lost if it ever needs to be retrieved.

2 Do not delete MQ sheets using basic Excel functions (i.e., delete a worksheet by right-clicking the
worksheet tab and selecting delete or by using Home [tab] > Cells [panel] > Delete [drop-down] >

Delete Sheets). Always use Q2P commands as using basic Excel methods for this action will cause
problems in Q2P.

1. From an active MQ sheet, select Q2P > MQ Sheet > Remove Bid Item to bring up the “Remove Bid Item”
dialog box (Figure 8.2).

| Remove Bid Item

X
Select the Bid ltems to remove out of the project: Reset Bid ltems Selection
=> 646.1020 used in MiscQtySheet - 646-Pavement Marking' Item deseription search
646 6020 used in MiscQlySheet -646-Pavement Marking' 2 .
= 6466220 used in MiscQiyShest -646-Pavement Marking' [ ]| FindNext

Bid Items to remove
Selected Bid ltems: 1
646.6020

(®) Remove from Current Sheet e

(©) Remove from All Sheets

Figure 9.2 “Remove Bid Item” dialog box.

2. Select the bid item you want to delete from the MQ sheet. You can only select one bid item at a time.
3. Select whether to delete it from the current sheet or from all the sheets it is included in.

4. Select “Remove” to complete the command and to see the resulting sheet (Figure 8.3).
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A EC D EFR G H I J K L M -
1_ Pavement Marking
2_
3]
4 | 546.1020 646.6220
Marking Line  Marking Yield Line
5_ Epoxy 4-Inch Epoxy 18-Inch
6 |CATEGORY STATION TO STATION  LOCATION LF EACH REMARKS
7
8 | oo 200400 - 200+50 LT & RT 100 -
9 | oo10 200450 - 200+60 LT & RT - 80
10 | o010 201450 - 201+60 LT&RT -
11| o010 201460 - 211460 RT 1,000 - L
12
13 | TOTAL 0010 1,100 30
14,
15
16 h
» | Biditems | 203.020001 | 415115... (&) : < 3

Figure 9.3 Summary sheet with bid item 646.6020 removed.

If the removed bid item was the sole bid item on the MQ sheet, the associated MQ
2* sheet would also be deleted from the workbook. This would also be reflected on the
main “Bid Items” worksheet where the removed bid item would no longer appear

within the list of bid items.

Wisconsin Department of Transportation

39




Quantities 2 Plans User Guide

10. Entering and Computing Quantities
Once all the miscellaneous quantity sheets (MQ sheets) and summary sheets have been inserted into Q2P,
enter the quantity information. Use the space to the right of the “REMARKS” column to calculate quantities
as needed.

Do not rename or delete the “Bid Items” worksheet, and never enter quantities on the main “Bid

A ltems” worksheet. Always enter the quantities on the MQ sheets. If quantities are entered in the
“Bid Items” worksheet and the Update Bid Item(s) command is run, all the manual entries will be
lost and replaced with the linked total on the associated MQ sheet or summary sheet.

10.1 Important Formatting Rules

You can use simple Excel functions to format the rows, columns, and cells to display the data as it will be
shown in the construction plan miscellaneous quantity sheets, but it is important to maintain some spatial
relationships between certain cells. Before you start heavily formatting, read the following sections for
important rules to follow.

10.1.1 “Total 00X0” Cell

The “TOTAL 00X0” text must contain that exact text content and format (i.e. TOTAL 0010, TOTAL 0020,
etc.). Changing it to “TOTAL 10,” for example, will cause errors (e.g. the code will not recognize that
category to define). Q2P creates the Excel cell Name and a SUM based on this spatial relationship and
that Name is how the quantity is referenced in various reports, outputs, and the main “Bid Items”
worksheet (Figure 10.1).

- Jr | =SUM(130:134)
A E C D E F G - | J K L

31 0030

32| o030

33| o030

34

35 TOTAL 0030 1,000 _|

36

37

38

39

Figure 10.1 Source of bid item category sum Name.

If these Names or links are inadvertently deleted or otherwise corrupted, running Q2P > MQ Sheet >
Rebuild References and Q2P > Tool > Update Bid Item(s) (Figure 10.2) will recreate the links (for only the
categories included in the list on the bottom of the “Bid Items” worksheet). The category “00X0” text
listed in column A is optional text for the miscellaneous quantity sheets and does not affect calculations.

= i 1234-56-78_mqw.xlsx - Excel

File Home Insert Page layout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do & Share

Tj 4jProject Setup BZl Published Bid Items | *= Create MQ Sheet =% Remove Bid Item ) Update Bid Item(s) @,To Estimator XML @—‘, From Estimator XML &5 About
[Z4 Category Setup F,: Project Bid Items =] Rename MQ Sheet «j{ Insert Bid Item(s) = Go to "Bid Items” EE)TO AWP Precon XML From AWP XML

R [£ Checked By ﬁ Rebuild References |0 Round Up Quantity AB: Order MQ Sheets [ Generate Cost Report
Project Data MQ Sheet Tool Export Import Help ~

Figure 10.2 “Rebuild References” and “Update Bid Item(s)” commands.
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Q2P utilizes (=SUM) to create the category totals, and this function will only add

Z>|< numbers. If a unit is included in the same cell as the quantity (e.g. “4887 CY” or “33
FT’” instead of “4887” or “33”), that quantity will be ignored. Enter stations as the
whole number (without the “+”) to be able to use them in calculations.

10.1.2 Multiple Categories
If multiple categories are used for the item, then a “PROJECT TOTAL” must also be shown on the plan

sheet table (Figure 10.3). This is either automatically generated if an MQ sheet is created with multiple
categories, or manually created if a category is added to a sheet via the workflow in 6.1 Add Categories.

A B € D| E G H 1 K L M N O P Q | R
1 —
2 —
3 | Asphalt Pavement
4 —
5 —
6 | 455.0605  460.6223 460.6424  465.0105
HMA HMA
Tack Pavement 3 Pavementd  Asphaltic

7 i Coat MT 58-28 %% MT 58-28 H**  Surface
8 |CATEGORY STATION TO  STATION LOCATION GAL TON TON TON REMARKS
9 | 10+00BP - 12+665 BP RT - - - 51 -
10 | o010 240455 - 247+74 LT &RT 213 775 477 -
11 242461 - 243+26 LT - - - 10 PRIVATE BIKE PATH
12 | 250430 - 254440 LT &RT 120 436 268 - -
13 | 251455 - 251475 LT - - - - -
14 | 252493 - 253+19 LT - - - 7 DRIVEWAY
15 | TOTAL 0010 333 1211 745 68
16
17 | -
18| 0030  450+89BL - 451+47BL RT - - - 28 PARKING LOT
19 | -
20 | TOTAL 0030 0 0 0 28
21 |
22 | (PROECTTOTAL 333 1211 745 95 )
23 |
24 PLACE THE 5" HMA PAVEMENT IN TWO LAYERS, A 3.25" LOWER LAYER AND A 2" UPPER LAYER
25 *BASED ON 0.05 GAL/SY APPLICATION RATE
26 | **BASED ON 112 LBS/IN/SY
27 |
28 |

< » ..| 416-Concrete | 460.2000 | 465-Asphalt Pavement | 506-Structure ... (¥ 4

Figure 10.3 “Project Total” on a sheet with multiple categories.
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10.2 Rounding
It is important to properly round the results of a formula. If cell formatting is used instead, then it is possible
that when summed on paper, the individual quantities will not add up to the total.

A B C D | E F__ G H ‘
1 /100.00 3.00 33.33 =A1/B1 34.00 =ROUNDUP(A1/B1,0)
2 100.00 3.00 33.33 =A2/B2 34.00 =ROUNDUP(A2/B2,0)
3 100.00 3.00 33.33 =A3/B3 34.00 =ROUNDUP(A3/B3,0)
4 100.00 =SUM(D1:D3) 102.00 =SUM(G1:G3)
5 .|
6 |All cells formatted as Category: Number; Decimal places:2

Figure 10.4 Example of how ROUNDUP makes formula results add up correctly on paper.

For example, format the cell for locating new passing zones and permanent signing to always show two
decimals. See FDM 19-5-3.3.3 Rounding Quantities for guidance on rounding quantities.

Q2P > MQ, Sheet > Round Up Quantity (Figure 10.5) will round up the selected quantity to the next integer.

= s 1234-56-78_mqw.xlsx - Excel

File Home Insert Page layout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do & Share

Tj 4jProject Setup BF] Published Bid Items | *= Create MQ Sheet =% Remove Bid Item &) Update Bid Item(s) @,To Estimator XML @—‘, From Estimator XML &% About
[Z4 Category Setup F,: Project Bid Items =] Rename MQ Sheet €= Insert Bid Item(s) 5~ Go to "Bid ltems” EE)TO AWP Precon XML From AWP XML

e [# Checked By E Rebuild References| O Round Up Quantity AB: Order MQ Sheets [ Generate Cost Report

Project Data MQ Sheet Tool Export Import Help ~
Figure 10.5 “Round Up Quantity” command.

: Note that there is no way to quickly undo this command, so this should be run when quantities
are near finalized. To undo, users must activate the cell and manually remove the =ROUNDUP(#,0)
formula.

: Do not round category totals. Only the actual data rows should be rounded. This is done to ensure
that the category totals directly sum up the rounded totals and those numbers match the totals
that are summed up on paper by contractors.
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10.3 Recording Computations
Being able to have the quantity calculations done right alongside the location data (Figure 10.6) is one of the

advantages of using Q2P to create MQ sheets.

K10 < Je =ROUNDUP(W10,0) v

A E C D E G H 1l K L M () Q S T u \ W X Y z -
1
2 Based on: HMA = 112.00 Ibs/in/sy
B] ASPHALT PAVEMENT Tack Coat (from "Rules of Thumb" sheet) = 0.05 gal/sy between layers
4
5 LOWER LAYER UPPER LAYER
6 455.0805  460.5223 460.6424 465.0105 3 MT58-28 § 4 MT 58-28 H

HMA HMA
TACK  PAVEMENT3 PAVEMENT4  ASPHALTIC
7 COAT ~ MT58-285** MT58-28 H**  SURFACE AREA DEPTH voL DEPTH| VoL
8 |CATEGORY STATION TO  STATION LOCATION GAL TON TON TON REMARKS SF sy IN LBS* TON | IN LBS* TON
9 10+00 BP 12+665 BP RT - - - 51 - 270215 30024 300 100880.27 50.44
10| o010 240+55 247+74 LT &RT 213 sl 477 - - 38290.00 4254.44| 325 1548617.75 [JEGIBM 200 952995.56 476.50
11 242461 243426 LT - - - 10 PRIVATE BIKE PATH 527.40  58.60 3.00 1968960 9.84
12 250+30 254+40 LT&RT 120 436 268 - - 21534.00 2392.67| 3.25  870930.67 435.47 | 2.00 535957.33 267.98
13 251455 251475 LT - - - - - 107.70  11.87
14 252493 253+19 LT - - - 7 DRIVEWAY 548.00  60.89 200 1363911  6.82
15 TOTAL 0010 333 1,211 745 68
16
17 -
18| 0030  450:89BL - 451+47BL RT - - - 28 PARKING LOT 2192.00 243.56 200 54556.44 27.28
19
20 TOTAL 0030 0 0 0 28
21
22 PROJECT TOTAL 333 1211 745 96
28
24 PLACE THE 5" HMA PAVEMENT IN TWO LAYERS, A 3.25" LOWER LAYER AND A 2" UPPER LAYER
25 *BASED ON 0.05 GAL/SY APPLICATION RATE
26 **BASED ON 112 LBS/IN/SY
27 -
4 » 465-Asphalt Pavement | 506-Structure 517-Structures 2 | 6463020 | 646- ... (¥) 4 »

Ready 5 Jase) g0 - 1 + 100%

Figure 10.6 Typical computations.

When quantity calculations are completed in Q2P, it is very easy to see how a change in pavement thickness,
for example, will affect project cost. If the change must be made after the MQ sheets are created, the
computations will carry-through all the way to the PowerPoint sheets, and only the PDF output needs to be

recreated.
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11. Establishing Unit Prices
Unit prices are entered on the “Bid Items” worksheet and are always entered into Q2P as present-day costs
without inflation. Unit prices and quantities are also verified at all Life Cycle changes and PMP phase changes.

Commonly used sources for item prices include: AASHTOWare Project Estimator™; comparable, nearby and
recent projects (via Bid Express® or WisDOT bid tab data); averages from WisDOT Central Office Structures;
and WisDOT Regional Technical Services staff for pavement pricing trends. More details can be found in the
WisDOT Facilities Development Manual 19-5-5 Construction Estimates. Bid item average price is not

appropriate to use at PS&E, but can be acceptable earlier in design.

Be aware of items that have a Pre-Established Price such as those found in the Pre-
Z)|< Established Price section of the AWP Knowledge Base.

A Do not change the prices of bid items that have pre-established prices. These are typically

incentive, on-the-job training, and SPV items (with DOL or HRS units). Enter prices to the nearest
cent. The SPV.0055 and SPV.0075 items are normally pre-established price items, but can be bid
normally depending on the item details. Pay special attention to these two items.

Always update the date in Q2P to reflect quantity and/or unit prices revisions.
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11.1 Exporting from Q2P into AASHTOWare Project Estimator™
1. Select Q2P > Export > To Estimator XML (Figure 11.1). This command will bring up the “Export as
Estimator XML file” dialog box (Figure 11.2).

= = 1234-56-78_mqw.xlsx - Excel

File Home Insert Pagelayout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat QTEII me what you want to do A Share

‘l'\j 4 Project Setup &1 Published Bid ltems  *=Create MQ Sheet =% Rernove Bid Item &) Update Bid Item(s) EB)TO Estimator XML From Estimator XML L% About
[ Category Setup [ Project Bid Items =] Rename MQ Sheet EE Insert Bid [tem(s) - Go to "Bid Items" [ To AWP Precon XML [} From AWP XML
New

[% Checked By ﬁ@' Rebuild References O Round Up Quantity AE,‘ Order MQ Sheets [ Generate Cost Report

Project Data MQ Sheet Tool Export Import Help ~

Figure 11.1 Importing Q2P into Estimator help.

Export as Estimator XML file et

Work Type: ~ Region: ™ Export

Figure 11.2 “Export as Estimator XML file” dialog box.

2. Enter the Work Type and Region, then select “Export” to create the XML.

This command is used to transfer items and quantities into Estimator for obtaining

Z* the bid regression prices. It is NOT used to create a complete Estimator file for use
with AWP Preconstruction. As such, all quantities will be imported into Estimator
under one category (0010).

3. Once the import file is created, save the XML named with the XXXX-XX-XXToEstimator.xml format in
your project folder, or use the default path as shown in Figure 11.3.

Export as Estimator XML file X
Work Type: |ASPH - Asphalt Paving v Region: SW » Export
C:WUsers\ DOTCXB\Documents\1234-56-78ToEstimator xml Saveas

Started exporting project info

Exporting Category — 0010...
€64 lines exported for Category - 0010.

>>>Export XML Estimate file completed!

Figure 11.3 “Export as Estimator XML file” dialog box after XML creation.
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4. Launch Estimator and follow the instructions below:
a. File > Import File
b. Navigate to exported XML (XXXX-XX-XXToEstimator.xml) and select “Open.”
5. Verify the project total in Estimator matches the construction cost total in Q2P.
6. Select and highlight the estimate total (XXXX-XX-XX - $X.XX).
7. Tousethe bid regression/average prices in Estimator, select Edit > Update Price Information: Restart.

8. Enter Work Type, Season, County, etc.
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11.2 Important Estimator Information

After restarting an estimate, most items will have a bid regression-based price, but some items will have a
$0.00 ad hoc price, and SPV items will receive a bid regression/average price that is completely inappropriate

because the item details are unknown to Estimator. Look out for these prices.

Typically, users should not be relying on bid regression prices for any item that

2* requires a supplemental description as by definition they are unique and cannot be
bid under a “standard” bid item, but those prices can be a good start for standard bid
items or reassurance for a price, especially early in the project lifecycle.

Figure 11.4 Item with supplemental description.

Estimator will also show blank item descriptions for item numbers that are not in the
% catalog, therefore the To Estimator XML tool in Q2P can be used to check older Q2P
files for items that may have been retired since their initial selection.

5 hd ITEM DESCRIPTION n | QUANTITY ~ ‘ UNIT - | UNIT PRICE - | COST n
465.0105 Asphaltic surface 500 TON $95.00 $47,500.00
465.0110 Asphaltic surface Patching 100 TON 595.003 $9,500.00
465.0120 Asphaltic surface Driveways and Field Entrances 200 TON $95.00! $19,000.00
506.7050.5.01 |Remou'ing Bearings (structure) (01. B-4-26) 11 EACH 52,004.013 $22,044.11
520.8700 Cleaning Culvert Pipes 8 EACH 5230.003 $1,840.00

It is recommended that you save your file prior to making the export to Estimator. Also, none of the data in

Estimator has a live link to Q2P, so the process must be repeated with each quantity or item change.
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11.3 Importing from AASHTOWare Project Estimator™ into Q2P
1. In Estimator, select File > Export Estimate File and name the file XXXX-XX-XXToQ2P.xml and save to
your project folder. Do not edit this file.

2. In Q2P, select Q2P > Import > From Estimator XML (Figure 11.5) to bring up the “Import Estimator
XML file” dialog box (Figure 10.6).

: This command will replace any existing notes, data, etc. that is currently in column K on the “Bid
Items” worksheet. Before running this command, verify column K is empty.

[u] s 1234-56-78_maw.xlsx - Excel

File Home Insert Page layout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do |& Share

Tj 4jProject Setup BZl Published Bid Items | *= Create MQ Sheet =% Remove Bid Item &) Update Bid Item(s) @,To Estimator XML
[Z4 Category Setup F,: Project Bid Items =] Rename MQ Sheet «j{ Insert Bid Item(s) EE)TO AWP Precon XML

5= Go to "Bid Items”
New

[% Checked By ] Rebuild References O Round Up Quantity AE,‘ Order MQ Sheets  [= Generate Cost Report
Project Data MQ Sheet Tool Export Import Help ~
Figure 11.5 “From Estimator XML” command.
Import Estimator XML file X Import Estimator XML file X

Choose Estimator XML file .. Choose Estimator XML file ..

C\Users\DOTCXB'\Desktop\1234-56-78ToQ2P xml

Import Import

Figure 11.6 “Import Estimator XML file” dialog box. Figure 11.7 File path of selected XML file (typically in project folder).

3. Select “Choose Estimator XML file...” to navigate to your saved file and select “Open.”

4. Confirm the file, select “Import” (Figure 11.7), then select “OK” on the next window (Figure 11.8).

Information X

56456 Bid Items found Unit Price from Estimator were
imported into Column - K.

Figure 11.8 “From Estimator XML” command.

5. Rename the column K heading to something like the date of the Estimator run. Otherwise, in the
future, that data might be mistakenly used when transferring data to/from Estimator, instead of the
current Q2P unit prices.
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11.4 Copying Unit Prices
1. From the “Bid Items” worksheet, select the first cell down from K14 (i.e. the first unit price from
Estimator) and use Ctrl + Shift + Down Arrow to select the range.

Quantities 2 Plans User Guide

: If there are any blank cells within the selected column, this command will only select the data up

to that first blank cell. You can continue to hit the Down Arrow until all data is selected.

2. Use Ctrl + C to copy the prices in column K.

3. Select the first cell with a price in the Q2P unit price column F.

4. Right-click > Paste Values (Figure 11.9).

- -

‘ 486 10
| 486 1D
1Ls
227 sy
3771 sy
2698 LF
1233 sy
5 EACH
1 EACH
4 EACH
179 LF
5311 cv
11956 cY
1 EACH
326 TON
3590 ToN
2712 TON
404 sy
53 sy
45 sy
1cy
333 GAL
1250 poL
1211 Ton
745 TON
96 TON
21490 LB
2870 cv
1Ls
2160 sy
1198 sy
3460 LF
240 cy

$1

§1
51
$1

- -

57 Go to sheet(s) include “201.0120"
(fd Quantity Link

E}S Cut

B2 Copy

o,

[ Paste Options:

T R A T
Of oMl & % Lo

Paste Special...

Smart Lookup

we

Translate

Clear Contents

Filter
Sort

Pick From Drop-down List...

Figure 11.9 “Paste Values” command.

QUANTITY | UNIT - [ UNIT PRICE - cosT -
486 1D $15.93 $7,743.44
486 1D $6.98 $3,389.85

lLs $0.00 $0.00
227 sy $9.91 $2,249.57
3771 sy $3.93 $14,831.34
2698 LF $3.61 $9,726.29
1233 sy $6.27 $7,729.68
5 EACH $257.44 $1,287.21

1 EACH $297.82 $297.82

4 EACH $347 .97 $1,391.88
179 LF $0.00 $0.00
5311 cv $10.06 $53,444.59
11956 cY $7.85 $93,902.42
1 EACH $0.00 $0.00
326 TON $23.10 $7,529.95
3590 TON $14.49 $52,026.28
2712 ToN $12.69 $34,415.28
404 sy $176.49 $71,301.15
53 sy $54.61 $2,894.22
45 sy $50.10 $2,254.32
lcy $626.16 $626.16
333 GAL $4.37 $1,456.54
1250 poL $1.00 $1,250.00
1211 ToN $67.94 $82,276.55
745 TON $71.93 $53,588.60
96 TON $127.28 $12,218.50
21490 LB $0.09 $1,826.65
2870 cv $581.23 $1,668,138.71
1Ls $0.00 $0.00
2160 sy $2.30 $4,959.36
1198 sy $4.84 $5,803.11
3460 LF $204.38 $707,161.72
240 cy $846.76 $203,223.12

Figure 11.10 Estimator prices successfully copied to “Unit Price”
column.

: If Estimator prices have a price to the thousandths place (e.g. 10.005), copying those prices into

the “Unit Price” column will retain those thousandths decimals even though the “Unit Price”

column is formatted to show a normal currency format (e.g. $10.01). Remember to review the

unit prices thoroughly prior to creating the ToPrecon.xml for uploading into AWP Precon.
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12. Viewing “80/20 Rule” Items for Documenting Unit Price Sources
WisDOT construction projects typically adhere to the Pareto principle and have 80% of their total contract
cost generated by about 20% of the total items. Therefore, it is important to focus on these items the most
when creating the engineer’s estimate and then document the basis for the unit price. This documentation
will aid others who may work on the project and/or be indispensable when responding to a justification
request after project let. The documentation can be as simple as including a note off to the right of Column K
in Q2P for the items and should detail the bid item unit price estimate source, such as: nearby, similar projects
(IDs); Bid Express; Estimator; regional trends; or a combination of these. Also, state whether or not one bidder
was assumed for the project. More information can be found in FDM 19-5-6 Construction Estimate

Documentation.

Items that fall outside the 80/20 rule can still end up being “significant items” and therefore require careful
consideration and should be documented, especially if they have a history of price fluctuation.

12.1 Use of Excel’s Sorting Function
CAUTION! Do not use the Excel Sort command on the “Bid Items” worksheet. Instead, highlight
and copy the Bid Item list into a new Excel workbook and do any sorting there.

Sort will only automatically expand the selection to data that is contiguous to the original selection. It will not
automatically expand the selection when run from an AutoFilter drop-down, even if the data is contiguous.
Sort also changes the row number of each line, but only does so within the AutoFilter group and does not
extend past column G in Q2P. This means if Sort is used from the filter drop-down, any price information
stored off the to the right of “Cost” will be out of order relative to the rest of the data. MQ sheets and summary
sheets will contain incorrect links as these do not auto-update when using Sort.

Save your file before sorting and use either of the following workflows in 12.2 or 12.3 to view the “80/20
Rule.”
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12.2 Using a Number Filter
1. Save your Q2P project file before sorting.

2. From the “Bid Items” worksheet, select Review > Changes > Unprotect Sheet (Figure 12.1).

H - ; 1234

File Home Insert Pagelayout Formulas Data EENEIE View Developer BLUEBEAM  Inquire  Acrobat Q2P Q Tell me what you want to do

= ek !:3 . Protect and Share Workbook
D [% ﬂ) a=x [,1Show All Comments D D

Thesaurus Check Smart Translate » Unprotect| Protect Share =
Accessibility Lookup 5 Show Ink lorkbook Workbook Q s @IEEES
Proofing Accessibility | Insights Language Comments Changes Ink ~

Figure 12.1 “Unprotect Sheet” command.

Once a protected sheet is unprotected, using any of the Q2P commands will
Z>|< automatically re-protect the sheet.

3. Usethe “Top 10...” Excel Number Filter.

=]
486 10 %l, Sort Smallest to Largest
486 1D
1Ls | il SortLargest to Smallest
227 sy
3771 sy Sort by Color »
2698 LF
1233 sy
5 EACH
1 EACH » B
4 EACH Number Filters 4 Equals...
S;I: :: Search jel Does Not Equal...
11956 cv (Select All) A Greater Than...
1 EACH $0.00
326 ToN $141.84 Greater Than Or Equal To...
3590/Ton $260.04 Less Than...
ZUEEC $297.82
4:; g [#1$514.80 Less Than Or Equal To...
$626.16 Between...
45 sy = v =
1 cy vl tR25 NA [ TO 10 ]
333 GAL LD i
1250 poL OK Cancel Above Average
1211 ToN =
745 Ton $71.93 §53,588060  Below Average
96 TON $127.28 $12,218.50 Customn Eilter
21490 L8 $0.09 $1,826.65 o
2870 cv $581.23 $1,668,138.71

Figure 12.2 Filter drop-down selected in “Cost” cell.

4. Change to Top | 20 | Percent. Select “OK.”

Top 10 AutoFilter ? X
Show
Top v| |20 S v

Figure 12.3 Top 10 AutoFilter changed to “Top 20 Percent.”

The “Bid Items” worksheet is now filtered on the top (by value) 20% of the items. For example, if you
had 50 bid items in total, this “Top 20% Percent” filter would display the 10 highest cost items
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assuming you have no duplicate costs (10/50= 20%). Those items may not equal 80% of your project’s
total cost and you may want to adjust your percentage amount in the number filter.

2] |7 56 - TTEM DESCRIPTION - [ auantImy - [ UNIT - [ UNIT PRICE - | cosT Edl
25| x 205.0100 Excavation Common 5311 ¢y $10.06 $53,444.59
26 x 208.1100 Select Borrow 11956 cv $7.85 $93,902.42
31 x 415.0410 Concrete Pavement Approach Slab 404 sy $176.49 $71,301.15
37 x 460.6223 HMA Pavement 3 MT 58-28 s 1211 TON $67.94 $82,276.55
38| x 460.6424 HMA Pavement 4 MT 58-28 H 745 TON $71.93 $53,588.60
41| x 502.0100 Concrete Masonry Bridges 2870 cy $581.23 $1,668,138.71
45| x 503.0146 Prestressed Girder Type I 45W-Inch 3460 LF $204 .38 $707 ,161.72
46 | x 504.0500 Concrete Masonry Retaining walls 240 cy $846.76 $203,223.12
47 | x 505.0400 Bar Steel Reinforcement HS Structures 71480 LB $1.04 $74,196.24
48 | x 505.0600 Bar Steel Reinforcement HS Ceated Structures 330905 LB $0.96 $318,661.52
52 x 513.4091 Railing Tubular Screening 624 LF $131.07 $81,789.55
71

72 CONSTRUCTION TOTAL: $3,677,317 .27
73 DELIVERY COST: 15 . 00%] $551,597.59
74 TOTAL : $4,228,914_87

Figure 12.4 View of “Bid Items” worksheet data that has been filtered by “Top 20 Percent.”

5. Highlight the group of “COST” total cells to display the total of the filtered Cost. Excel displays the sum
of a selection on the bottom right of the status bar. For this example, the top 20% of items is equal to
about 93% of the total project construction cost. You may choose to re-filter the list down to less than
20% to display closer to 80% of project cost — just be aware that these are the items that require the
most scrutiny when developing the engineer’'s estimate and require some level of price

documentation.

-] QUANTITY -| UNIT-| UNIT PRICE - cosT r

11956 cy $8.00 $95,648.00

3590 TON $15.00 $53,850.00

404 sy $175.00 $70,700.00

1211 TON $68.00 $82,348.00

745 TON $72.00 $53,640.00

2870 cY $580.00 $1,664,600.00

nch 3460 LF $205.00 $709,300.00
s 240 cy $845.00 $202,800.00
ctures 71480 LB $1.00 $71,480.00
ed Structures 330905 LB $1.00 $330,905.00
624 LF $131.00 $81,744.00

CONSTRUCTION TOTAL : $3,690,872.00

DELIVERY COST: 15.00%] $553,630.80

TOTAL : $4,244 ,502_80

204-Removals | 208-Earthwo ... () 4

Average: $310,637.73 Count: 11 Sum: $3,417,015.00 2=z

Figure 12.5 Using the selection sum feature of Excel.

<[ QuANTITV - [ UNIT - [ UNIT PRICE - |

11956/cY 8] Sort Smallest to Largest
3590 TON

404 sy
1211 ToN
745 TON

&l Sort Largest to Smallest
Sort by Color

- \

2870icY |Yx Clear Filter From "COST"

3460 LF

240 cv
es 71480 LB
tructures 330905 1g | V| Number Filters
G24|LF Search
e — [ (select Ally
DELTIVERY CO! Clsooo
[1$144.00
.......... Tot [$264.00
[TJ$300.00
[1$520.00
ESCRIPTION) EFUNI []$598.00
oadway Construction)  80% [Merosnn
Jacement B-XX-XXX) 75%
(Retaining walls) 25% S

04-Removals | 208-Earthwo ... (¥) 4

Cancel

s

=]

Figure 12.6 Filter drop-down, used to clear the Number Filter.

6. Select the filtered cells and use Home > Font > Text Highlight Color to highlight your selected “80/20”
items to a certain color. This will differentiate your important items from the rest once you remove

the number filter.

7. Select the filter drop-down in the “Cost” cell again to clear the Number Filter (Figure 12.6).
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12.3 Using Conditional Formatting
1. Save your Q2P project file before sorting

From the “Bid Items” worksheet, select Review > Changes > Unprotect Sheet (Figure 12.7).

Insert Page Layout Formulas Data [EVEN

View Developer BLUEBEAM Inquire Acrobat Q2P Q Tell me what you want to do

|§ | [‘% ﬂ) ek . Protect and Share Workbook
@ ad=x [,1Show All Comments «
Thesaurus Check Smart Translate P Unprotect| Protect Share =
Accessibility Lookup 5 Show Ink lorkbook Workbook Q s @IEEES
Proofing Accessibility | Insights Language Comments

Changes Ink ~

Figure 12.7 “Unprotect Sheet” command.

3. Highlight all the cost cells in column G (match the actual range of Costs).

4. Select HOME > Styles > Conditional Formatting > Top/Bottom Rules > Top 10%...

: - Z-A
&’:"‘ :“ S<Delete - [¥]- ZY p
al Fol

Condition as Cell EIFormat' _ Sort & Find &
Formatting ~ Table - Styles - Filter - Select |

' Cells Editing
Highlight Cells Rules *
¢ &

’

!N E1A*D1ANN)

L Top/Bottom Rules " Top 10 Items...
Data Bars Top 10 %...
[:] Color Scales 4 Bottom 10 Items...
Icon Sets 4 Bottom 10 %...

-

New Rule...
I 1 New Rule T Above Average...
| r‘ Clear Rules .
c E Manage Rules... =] Below Average...
LB 310U |
LB $1.00 More Rules...
EACH $93.00 ns—

Figure 12.8 Conditional Formatting Excel command.

5. Set the conditional formatting to 20% along with the desired highlighting. Note that this “20%”

functions the same way as the number filtering method listed above. You may have to adjust this
percentage amount to identify all your 80/20 items.

Top 10% ? X

Format cells that rank in the TOP:

20 |3 %with Light Red Fill with Dark Red Text | v

Figure 12.9 Top 10% Conditional Formatting dialog box.

Now all Costs can be viewed at the same time, with the top 20% items highlighted.

Wisconsin Department of Transportation

53



Quantities 2 Plans User Guide

460.
460.
465.
501.
502.
502.

502.
502.
503.
504.
505.
505.
506.
506.

6223
6424
0105

1000.

0100

3100.

3200
3210
0146
0500
0400
0600
2605
2610

56

~ ITEM DESCRIPTION -

HMA Pavement 3 MT 58-28 s

HMA Pavement 4 MT 58-28 H

Asphaltic surface

Ice Hot Weather Concreting

Concrete Masonry Bridges

Expansion Device (structure) (01. B-13-572)
Protective surface Treatment

Pigmented Surface Sealer

Prestressed Girder Type I 45wW-Inch
Concrete Masonry Retaining walls

Bar Steel Reinforcement HS Structures

Bar Steel Reinforcement HS Coated Structures
Bearing Pads Elastomeric Nen-Laminated
Bearing Pads Elastomeric Laminated

QUANTITY - UNIT ~

1211 ToN
745 ToON
96 TON
21490 LB
2870 cy
1lLs
2160 sy
1198 sy
3460 LF
240 cy
71480 LB
330905 LB

28 EACH

28 EACH

UNIT PRICE - |
$68.
$72.

$125.

00
00
00

COST

$82,348.00
$53,640.00
$12,000.00
$2,149.00
$1,664,600.00
$0.00
$5,400.00
$5,990.00
$709,300.00
$202,800.00
$71,480.00
$330,905.00
$2,604.00
$23,464.00

Figure 12.10Bid items with the higher Cost items highlighted as they are included in the top 20%.

The formatted cells will change as new items are added to the project, or existing prices are revised.

460.
460.
465.
501.
502.
502.
502.
502.
503.
504.
505.
505.
506.
.2610

506

6223
6424
0105

0100

3200
3210
0146
0500
0400
0600
2605

1000.

3100.

56

- ‘ ITEM DESCRIPTION
HMA Pavement 3 MT 58-28 s
HMA Pavement 4 MT 58-28 H
Asphaltic surface
Ice Hot weather Concreting
Concrete Masonry Bridges
Expansion Device (structure) (01. B-13-572)
Protective surface Treatment
Pigmented Surface Sealer
Prestressed Girder Type I 45wW-Inch
Concrete Masonry Retaining walls
Bar Steel Reinforcement HS Structures
Bar Steel Reinforcement HS Coated Structures
Bearing Pads Elastomeric Non-Laminated
Bearing Pads Elastomeric Laminated

- [ auanTITy - |

1211 TON
745 TON
96 TON
21490 LB
2870 Cy
1Ls
2160 sy
1198 sy
3460 LF
240 cvy
71480 LB
330905 LB

28 EACH

28 EACH

UNIT ~

[ UNIT pRICE =
$40.00

COsT

$48,440.
$53,640.
$12,000.
$2,149.
$1,664,600.
$0.
$5,400.
$5,990.
$709,300.
$202,800.
$71,480.
$330,905.
$2,604.
$23,464.

|
00
00
00
00
00
00
00
00
00
00
00
00
00
00

Figure 12.11 Bid items with item 460.6223 Cost no longer highlighted as the unit price was revised down.

Use a Number Filter to quickly sum these top 20% items to verify that 20% is still the appropriate

value to use for delineating the items that total around 80% of project cost. This should be done

especially when major changes have occurred to the project estimate.

To clear Conditional Formatting, use HOME > Styles > Conditional Formatting > Manage Rules... while
the range is still selected.

Conditional Formatting Rules Manager

Show formatting rules for: G ~

[ | New Rule... [/ Edit Rule... C < Delete Rule )

Rule (applied in order shown)  Format

Top 20% AaBbCcYyZz

Applies to

=$G$14:5G$69

Stop If True

[

54

Close

Figure 12.12 Conditional Formatting Rules Manager which allows deletion of set rules.
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13. Creating the Miscellaneous Quantity Plan Sheets

13.1 Setting up the Power Point Slide Template
1. Navigate to the Q2P web page to access and download the PowerPoint templates for creating the MQ
sheets.

2. Open a new Miscellaneous Quantities plan sheet template, titled PowerPoint MQ Plan Sheet.pptx.
There is also a rotated plan sheet template for use as needed.

Subscribe to WisDOT's Q2P distribution list.
Enter your name and email address in the boxes below and click subscribe.

Email address (required): | |

Your name (required): | |

Additional Resources

-
PowerPoint MQ Plan Sheet.pptx (Horizontal sheet template to be used for MQ plan sheets)
\PowerPoint MQ Plan Sheet Rotated.pptx (Vertical sheet template to be used for MQ plan sheets)

WisDOT Estimating Tools Website
WisDOT AASHTOWare Project (AWP) Knowledge Base (Instructions on creating estimates and using AWP)

Figure 13.1 PowerPoint sheet templates found on Q2P website.

3. Save the PowerPoint sheet working file in the same directory as the project’s Q2P workbook working
file and name it 030200_mq.PPTX or XXXX-XX-XX_mq.PPTX. It should remain there until after PS&E.

4. Fill in the project title block information. This is done by editing the “Slide Master.” Go to VIEW >
Master Views > Slide Master.

F A G B = 020200_mg.pphx - PowerPoint ? @ - O %X
HOME  INSERT  DESIGN  TRANSITIONS ~ AMIMATIONS  SUDESHOW  REVIEW | VIEW | ACROBAT -
EEEEE v [B[Q [0 B8 |5 Brme | 5 |
Gricllines = Grayscale R Cascade
Normal Cutline Slide Notes Reading | Slide Mlandout Notes Motes | Zoom Fitto ew Switch | Macros
View Sorter Page View | Master Waster Master Guides Window | mm Black and White | windaw 57 Move Split | wingows -

Presentation Views Master Views Show Fl Zoom Color/Grayscale Window Macros ~

Slide Master View

L Master slides control the look of
your entire presentation, including
colors, fonts, backgrounds, effects
and just about everything else.

¥ou can insert a shape or a logo on
a slide master, for example, and it
will show up on all your slides
automatically.

||

SUDE1 OF 1 0= = NOTES B COMMENTS

Figure 13.2 Normal View.
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Making edits to the “Slide Master” will translate those edits to be used on all sheets.

5. Click on the Slide Master #1 and then edit the text boxes at the bottom of the plan sheet.

B A O T = 030200_maq.pptx - PowerPoint DRAWING TOOLS 7 A - O X
SUDEMASTER | HOME  INSERT  TRANSITIONS  ANIMATIONS — REVIEW  VIEW  ACROBAT FORMAT -
\lj ﬂ TG Delete D — B8 Colors - /5] Background Styles -
IS} Rename [A] Fonts - Hide Background Graphics
TnsertSlide Tnsert Master  Insert Footere | Themes : Slide
Master Layout |# PTesenve | | ayaut placeholder - [0 Fffects - Size~ | Master View
Edit Master Master Layout Edit Theme Background 5l Size -
€
2
*
E3
At == —— - El T

SUDE MASTER  [[2

Figure 13.3 Slide Master View.

Note that there is a second master slide which is blank. This can be used to create a
Z* second sheet, if different project information is required within the same PPTX file.

6. When finished, click the “Close Master View” button.

7. In Normal view, use HOME > New Slide to create multiple copies of the slide as needed to
accommodate the Q2P miscellaneous quantity data.

FHS®S 05 - 030200_ma.ppix - PowerPoint 7 E - O %
HOME | INSERT  DESIGN  TRANSITIONS  ANIMATIONS  SLUDESHOW  REVIEW  VIEW  ACROBAT -
LI [ Layout - r\') (] # Find
D B ~ Reset < o 5 23c Replace -
Paste New Shapes Arrange Quick
- ¥ | Slide- Mgection- N =" Siyles~ @@ S It Select -
Clipboard 1 Slides Font Paragraph Drawing Editing ~

1

i iy s — i — -

SLIDE3 OF 3 = = NOTES B COMMENTS B

Figure 13.4 PowerPoint New Slide.
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13.2 Copying Data onto PowerPoint Slide
1. In Q2P, navigate to an MQ sheet and highlight the range of data to be included on the plan sheet.

2. Select PAGE LAYOUT > Print Area > Set Print Area.
3. Right-click < Copy or select HOME > Clipboard > Copy to copy the selection.

Q2P works best when a Print Area is linked to PowerPoint since this allows users to

¥k insert rows and columns and have those changes reflected in PowerPoint. If only a
cell range is selected, rows will shift out of view when new ones are inserted into the
table. Alternatively, Use FORMULAS > Defined Names > Define Name, to break-up
sheets that must span two PowerPoint sheets.

4. NON-LINKED MQ SHEETS —In PowerPoint, Right-click > Paste Options > Keep Source Formatting. This
method doesn’t have any links to potentially break, but will require a manual Copy + Paste for every
change to any MQ table in your Q2P file.

5. LINKED MQ SHEETS - In PowerPoint, select HOME > Clipboard panel > Paste Drop-down menu >
Paste Special... and select the “Paste link” radio button. Choose “Microsoft Excel Worksheet Object”.

1234-56-78_mq.pptx - PowerPoint

Insert Design Transitions  Animations Slide Show Review View BLUEBEAM Acrobat Q Tell me | Share [
= =- 8 O o [m 8 I Create PDF
D 2] B T U S abeh ] . i] X {@}Change Settings
Paste New — - o Arrange Editing Create and Share Request L@ Batch PDF
- Slide~ &7 - - Adobe PDF  Signatures
Clipboard = Slides Font Paragraph Drawing Adobe Acrobat Bluebeam ~
1
Paste Special ? X
3 3
Source: Microsoft Excel Worksheet

203.0200.01!R1C3:R14C9
As:

| Display as icon

O paste Microsoft Excel Worksheet Object \

(®) {paste linki |Attach Hyperlink

Result

Inserts a picture of the clipboard contents into your presentation. Paste

Link creates a shortcut to the source file so that changes to the source file
> will be reflected in your presentation.

FROIECT NG, v Teounr WISCELLANEGUS GUANTITES SHEET: Ie

Slide 10f 1 [I% =nNotes |[E &5 g -—14 + 47% £

Figure 13.5 Paste Special in PowerPoint.

Make sure the “Display as icon” checkbox is NOT checked.
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6. Use the Right-click > Format Object to scale to a standard percent for the sheets, or set the insertion
point manually if attempting to align multiple items.

[ 1
X Cut
By Copy 204.0245.01
CATEGOI i, Paste Options: LOCATION LF
oor0 B 5 (oA LT & RT 110
Linked Macro-Enabled Worksheet Object *
Update Link OTAL 0010 110
[ | Growp
0040 W, EBring to Front RT 21
% Sendto Back RT 34
8 Hyperin. RT 14
Save as Picture... OTAL 0040 69
& Format Object...
L ‘ PROJECT TOTAL 179 I
)
' MISCELLANEOUS QUANTITIES SH
23, 2016 FLOTBY: CAB. PLOT MAME - PLOT SCALE : 111

Figure 13.6 Right-Click Menu

Format Object
IR -

4 SIZE
.
Width 454" :
Rotation s
Scale Height

Scale Width 100% 2
Lock aspect ratio
Relative to original picture size

Best scale for slide show
Resolution 640480
I POSITION
I TEXT BOX

b ALT TEXT

Figure 13.7 Format Object dialog box.

Note that “Lock aspect ratio” needs to be checked.
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7. Use the standard PowerPoint tools to create lines (HOME > Drawing) to separate items.

O

|*a 7 Shape Fill

o

.y & [# Shape Outline
Arrange Quick

- Styles - & Shape Effects

Drawing

Figure 13.8 Drawing lines in PowerPoint.

Holding the shift key while creating or lengthening a line will lock in the direction to
T  90°/180°/270°/360.

Once miscellaneous quantity sheets are linked to PowerPoint, the Q2P XLS file should not be moved or
renamed, as links are not relative, they are absolute. Under the FILE > Info > Related Documents > Edit
Link to Files, the links may be reviewed for problems and file source locations manually updated for each
link, one at a time, if necessary.

[ Edit Links to Files

Figure 13.9 Use “Edit Links to Files” to review links between Q2P and PowerPoint.

A Always have the associated Q2P workbook open BEFORE opening the PowerPoint MQ plan sheets.
This will avoid extremely slow processing due to PowerPoint needing to open and close Excel to
update every link in the file.
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13.3 Printing the Miscellaneous Quantity Sheets
The MQ plan sheets must conform to the standards in FDM 15-1-30, Miscellaneous Quantity Sheet. Use the
following steps to create the PDF file from PowerPoint for the final electronic plan (ePlan).

1. Select FILE > Print and set the Printer to “Adobe PDF” and verify “All Slides” are to be printed.

2. Click “Printer Properties” to access the Print dialog box.

4 B
@ = Adobe POF Document Properties ﬂ
- Paper/Qualty u Adobe PDF Settings
Info. P rl nt PAdobe PDF Conversion Settings
Usge these settings to create Adobe PDF documents suitable for reliable viewing and printing
New Copies: 1 - Q of business documents. Created PDF documents can be opened with Acrobat and Adobe

Reader 6.0 and later.

Open

Fm Default Settings: |Standard j Edit..
Save As Printer : Adobe PDF Securty: |None |

¢ AdobePDF Adobe PDF Output Fold
Save as Adobe %fdf Pe:dj - obe put Folder |Pmmpt for Adobe PDF filename j Browse. ..
PDF - teady .
Printer Properties Adobe PDF Page Size: |[RES K - Add
Print Setti \ [¥ View Adobe PDF results
ettings [v Add document information
Share Print All Slides
/ﬁ Print entire presentation T [¥ Rely on system fonts only: do not use document forts
i Slides: [¥ Delete log files for successful jobs
Full Page Slides
Close . o
D Brint 1 slide per page [~ Ask to replace existing PDF file
—  Collated
[E -
Account == 123 123 123 |
Edit Header & Footer L

Figure 13.10 Accessing printer properties. Figure 13.11 Basic Print Settings for Adobe PDF.

3. Set “Adobe PDF Page Size” to 11 x 17.

4. Change the “Layout” to Landscape and hit “OK.”

g B
= Adcbe PDF Document Properties ﬂ

Layout | Paper/Qualiy | Bl Adobe PDF Settings

Orientation:

Landscape -

Page Format

Pages per Sheet 1 -

Figure 13.12 Layout changed to Landscape.

5. Select “Print” and save the PDF as 030200_mg.pdf in the SheetsPlan\pdf folder in the Civil 3D directory
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14. Print Project Cost Report
The Cost Report is the engineer’s estimate, grouped by category.

1. Prior to creating a Cost Report, use Q2P > Project > Checked By and enter the appropriate initials and
date. This information will appear on the Cost Report footer.

2. Select Q2P > Export > Generate Cost Report (Figure 14.1) to generate and print (Figure 14.2) the project
cost report which displays the estimate totals by category (Figure 14.3).

= s 1234-56-78_mqw.xlsx - Excel

File Home Insert Page layout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do & Share

Tj 4jProject Setup BZl Published Bid Items | *= Create MQ Sheet =% Remove Bid Item &) Update Bid Item(s) @,To Estimator XML @—‘, From Estimator XML &5 About
N [Z4 Category Setup F,: Project Bid Items =] Rename MQ Sheet «j{ Insert Bid Item(s) 5 Go to "Bid ltems”  [41To AWP Precon XML From AWP XML
o [# Checked By E Rebuild References O Round Up Quantity AE: Order MQ Sheets  |[=' Generate Cost Report
Project Data MQ Sheet Tool Export Import Help ~

Figure 14.1 “Generate Cost Report” command.

Generate Cost Report X

Generate Print as PDF

Started generating Costs Report

Generating Category - 0010...
Running Category - 0010 total.

56 lines generated for Category - 0010.

Generating Category - 0020...
Running Category - 0020 total.

3 lines generated for Category - 0020.

Generating Category - 0030...
Running Category - 0030 total.

1 lines generated for Category - 0030.

>>>Generate Costs Report completed!

Figure 14.2 Generate Cost Report window after report generation is complete.
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6/10/2019 1:15PM
File Name: P:\State\STH1\1234-56-08,78\EstQnity\1234-56-78_maw.xisx
ENGINEER'S ESTIMATE / Q2P WORKBOOK PRELIMINARY COST
PROJECT MANAGER: John Doe 6/10/2019 $757,175.00
CONST. I.D.: 1234-56-78
TITLE: Waukesha - Superior
LIMITS: Green Bay to La Crosse
HIGHWAY : STH 1
COUNTY: Eau Claire
PROGRAM CODE: 303 STATE HIGHWAY REHABILITATION
CONCEPT CODE: RESURF RESURFACING
NET C/L MILES: 0.00 .
ITEMS ITEM DESCRIPTION QUANTITY | UNIT UNIT PRICE cosT
CATEOGRY 0010 Roadway Construction (80% Federal 20% State)
201.0105 Clearing 350|sTA $999.00 $349,650.00
201.0205 Grubbing 350|sTA $50.00 $17,500.00
619.1000 Mobilization 0.25[EACH $75,000.00 $18,750.00
643.5000 Traffic Control 1feacH $5,000.00 $5,000.00
CATEGORY 0010 TOTAL: $390,900.00
CATEOGRY 0020 Bridge overla (80% Federal 20% State)
|502.0100 Concrete Masonry Bridges 500|(Y | $400.00 $200,000.00
|619.1000 Mobilization O.ZSIEA(H I $75,000.00 $18,750.00
CATEGORY 0020 TOTAL: $218,750.00
CATEOGRY 0030 Bike/Ped Trail (100% City of Wisconsin Rapids)
465.0105 Asphaltic Surface 1000|TON $100.00 $100,000.00
619.1000 Mobilization 0.25[EACH $75,000.00 $18,750.00
SPv.0090.01 Special (01. Yarn) 25|LF $1.00 $25.00
CATEGORY 0030 TOTAL: $118,775.00
CATEOGRY 0040 Sanitary Sewer & Watermain (100% City of Rhinelander)
|619.1000 Mobilization 0.25|EACH | $75,000.00 $18,750.00
|677.0500.S Install Video Detection Camera l|EA(H | $10,000.00 $10,000.00
CATEGORY 0040 TOTAL: §28,750.00
CONSTRUCTION COST ESTIMATE: $757,175.00
DELIVERTY COST: 15% $113,576.25
PROJECT TOTAL: $870,751.25
Checked By:
Date: 6/10/2019 1of 1

Figure 14.3 Q2P Cost Report.

3. Save the PDF to your project folder. Alternatively, the main “Bid Items” worksheet can be printed from

the standard Excel print dialog to disregard categories and just view the item costs across all categories.

Delete unused category rows (using Excel commands) from the MQ sheets and run Q2P > Tool >

Update Bid Item(s) to refresh the links to the main “Bid Items” worksheet.

Wisconsin Department of Transportation
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) | CATEGORY

203.0200.01

203.0200.01
Removing Old Structure
(STA. 248+00)
STATION TO  STATION LOCATION LS

REMARKS

i o o ) o ) o i

0010

o020

1

TOTAL 0010 1

TOTAL 0020 | ] .

Figure 14.4 MQ sheet with unused category left in place.

A miscellaneous quantity sheet must only contain the categories that are required.
%% Do not keep empty CATEGORY 0020, 0030 totals on the MQ sheet (unless intended to
be used at a later time).

Wisconsin Department of Transportation
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15. Creating the Upload File for AASHTOWare Project Preconstruction™

Prior to creating the upload file for AWP Preconstruction, verify all empty categories are deleted
from each miscellaneous quantity sheets.

1. Select Q2P > Export > To AWP Precon XML (Figure 15.1). This command will bring up the “Export as
Estimator XML file” dialog box (Figure 15.2).

= s 1234-56-78_mqw.xlsx - Excel

File Home Insert Page layout Formulas Data Review View Developer BLUEBEAM Inquire  Acrobat Q Tell me what you want to do & Share

Tj 4jProject Setup BZ] Published Bid Items = *= Create MQ Sheet =% Remove Bid Item &) Update Bid Item(s) [l To Estimator XML @—‘, From Estimator XML &5 About

N [Z4 Category Setup F,: Project Bid Items =] Rename MQ Sheet «j{ Insert Bid Item(s) 5~ Go to "Bid ltems” EE)TO AWP Precon XML From AWP XML
o [# Checked By E Rebuild References O Round Up Quantity AE: Order MQ Sheets  [=] Generate Cost Report

Project Data MQ Sheet Tool Export Import Help ~

Figure 15.1 “To AWP Precon XML” command.

Export as AWP Precon XML file X

Work Type: ~  Region: v Export

Figure 15.2 “Export as AWP XML file” dialog box.

2. Enter the Work Type and Region, then select “Export” to create the XML.
3. Once the import file is created, save the XML named with the XXXX-XX-XXToPrecon.xml format in your
project folder, or use the default path as shown in Figure 15.3.

Export as AWP Precon XML file X

Work Type:  ASPH - Asphalt Paving ™ Region:  SW bd Export

C:\Users\DOTCXB'\Documents\1234-56-78ToPrecon xml

Saveas ...

Started exporting project info

Exporting Category — 0010...
64 lines exported for Category - 0010.

Exporting Category - 0020...
11 lines exported for category - 0020.

Exporting Category — 0030...
4 lines exported for Category - 0030.

>>>Export XML Estimate file completed!

Figure 15.3 “Export as AWP Precon XML file” dialog box after XML creation.
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<?xml version="1.0" encoding="UTF-8"?>
- <Estimate>
<Estimateld>1234-56-78</Estimateld>
<SpecYear>03</SpecYear>
<UnitSystem>E</UnitSystem>
<WorkType>ASPH</WorkType>
<DistrictNumber>SW </DistrictNumber>
<Description>WAUKESHA - SUPERIOR GREEN BAY TO LA CROSSE </Description>
- <EstimateGroup>
<GroupNumber>0010</GroupNumber>
<Description>0010</Description>
<Estimateltem>
<LineNumber>0010</LineNumber>
<ItemCode>201.0120</ItemCode>
<Quantity>486.000</Quantity>
<UnitPrice/>
<SupplementalDescription/>
</Estimateltem>
<EstimateItem>
<LineNumber>0020</LineNumber>
<ItemCode>201.0220</ItemCode>
<Quantity >486.000</Quantity>
<UnitPrice/>
<SupplementalDescription/>
</Estimateltem>
<Estimateltem>
<LineNumber>0030</LineNumber>
<ItemCode>203.0200</ItemCode>
<Quantity>1.000</Quantity>
<UnitPrice/>
<SupplementalDescription>01. 248+00</SupplementalDescription>
</Estimateltem>
<EstimateItem>
<LineNumber>0040</LineNumber>
<ItemCode>204.0100</ItemCode>
<Quantity>227.000</Quantity>
<UnitPrice/>
<SupplementalDescription/>
</Estimateltem> Vv

Figure 15.4 Sample XXXX-XX-XXToPrecon.xml generated by Q2P.

4. Review the XXXX-XX-XXToPrecon.xml file (Figure 15.4) for completeness and/or errors prior to
uploading into AWP Preconstruction. Pay special attention to the items with supplemental descriptions.

Note how the “ltem Description” from Q2P is not actually exported to AWP Preconstruction. Rather, it is
populated in AWP Preconstruction from the item number.
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16. Importing the File into AASHTOWare Project Preconstruction™
Prior to importing the XXXX-XX-XXToPrecon.xml into AWP Preconstruction, verify that the
Project is properly setup in AWP Preconstruction. This will avoid errors during the upload process.

For instructions on uploading the XXXX-XX-XXToPrecon.xml file into AWP Preconstruction, see the WisDOT
AASHTOWare Project™ (AWP) Knowledge Base. The help documentation refers to the XXXX-XX-XXToPrecon.xml
file originating from Estimator, but the Q2P version is also a valid source (Figure 15.3).

AASHTOWare Project  Preconstruction  Construction Materials  Civil Rights and Labor  Downloads  External Resources

How to Create an Engineer's Estimate

DL RO C TS e
Search o

Creating an Estimate in Estimator (optional) »

Estimator Catalog, Licensing, Installation and Configuration

Creating an Estimate in Preconstruction » 5 A 5 5
g Exporting a Project from Preconstruction to Estimator

v . . ) . Creating a Proposal for PSE Submittal » Creating an Estimate in Estimator
: >
ou are here: Preconstruction > Creat g oyt | pres oo Designers

Importing an Estimate into Preconstruction
FAQs for Preconstruction

Importing an Estimate

Summary of Preconstruction Changes
Last updated: 2018-11-01

Figure 16.1 Navigation to “Importing an Estimate into Preconstruction.”
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APPENDICES

Appendix A. Troubleshooting

A-1  “########” Displays in a Cell
When a cell in Excel does not have sufficient width to display the entire number, it will display a cell filled

with “#”. Increasing the width of the column will fix the issue.

d A B G D E F G El I I K
1 HAULING EXCESS SHOULR PR MATERIAL
2
3
- 305.0504.5
D | CATEGORY STATION TO STATION LOCATION CY REMARKS
6
7 oow0 495+00 - 645+93
10 oo10 645+93 - 1296+63 200
11
2 TOTAL 0010  ##Sssssa##s
11
Figure A-1.1 Insufficient column width.

Double-clicking in the area between columns headings (columns | and J in our example) will automatically
change the width to an amount that will allow all content to display properly. Excel will do this when the
mouse cursor has changed to the Excel “resize column width” cursor.

H | 4-|; J
=

Figure A-1.2 Resize column width cursor.

You can also right-click on the column name (I) and select “Column Width...” to change the width to a set

luddaC-|8 -|A" A" $ - % 9 jl
B I - A-RAE |
H I T

larger value.

o 1
Terzal & | Cut
53| Copy
305.050 [ Paste
Paste Special...
FEZFEEEH] Insert

Delete

110 P Clear Contents
2?' Format Cells...
LColumn Width... %
Hide

Unhide

Figure A-1.3 Right-click menu for accessing the “Column Width...” command.
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A-2  “#REF !” Appears in the Quantity Total on the main “Bid Items” Worksheet
This error occurs most often when a category has been deleted from an MQ sheet and Update Bid Item(s)
is run before Rebuild References. The solution is to first rebuild the references after deleting the category,

which will create the proper links, then run the Update Bid Item(s) command.

A B C D E F (|~
1o ENGINEER'S ESTIMATE / Q2P WORKBOOK CONSTRUCTION COST ESTI|
2 |w PROJECT MANAGER: JOHN DOE b
3+ CONST. I.D.: 1234-56-78
4 |luwn TITLE: WAUKESHA - SUPERIOR
5 ws= LIMITS: GREEN BAY TO LA CROSSE
6 ow HIGHWAY: STH 1
7wk COUNTY: Adams PSE Date: 5/13,
8 v PROGRAM CODE: 303 STATE HIGHWAY REHABILITATION Let Date: 8/1/
9 CONCEPT CODE : RESURF RESURFACING NET C/L MI: 0.(
10 | TOTAL SCHEDULE OF BID ITEMS WISDOT STANDARD SPECIFICATIONS
11| 64 TOTAL BID ITEMS
12 b 64 v ITEM DESCRIPTION | QUANTITY - | UNIT - \ UNIT PRICE ~ co
56 | x 517.1010.5.02 Concrete Staining (structure) (02. R-13-251) 120 sF
57| x 517.1010.5.03 Concrete Staining (structure) (03. R-13-253) 220 sF
58 | x 517.1010.5.04 Concrete staining (structure) (04. R-13-254) 740 sF
59 x 517.1050.5.01 Architectural surface Treatment (structure) (01. B-13-572) 4370 sF
60| x 646.1020 Marking Line Epoxy 4-Inch #REF ! ILF $10.00
61| x 646.3020 Marking Line Epoxy 8-Inch 598 LF
62| x 646.6020 Marking stop Line Epoxy 12-Inch #REF ! LF $10.00
63| x 646.6220 Marking Yield Line Epoxy 18-Inch #REF ! EACH $10.00
64| x 652.0225 Conduit Rigid Nonmetallic Schedule 40 2-Inch 1317 LF -

» Bid Items | 201-Clearing and Grubbing 203.0200.01 | 204-Remov ... (+) 4 »
Ready Filter Mode 5] =) B - B + 90%

Figure A-2.4

A-3 Q2P Ribbon Fails to Load

“#REF!” error on “Bid Items” worksheet after deleting category from MQ sheet.

If the Q2P ribbon fails to load when the workbook is opened, refer to the “Repair Q2P Excel Add-In” tool
mentioned in section 1. Before You Get Started.

A-4  Small Triangles Appear in Cells
If “Error Checking” is enabled in Excel, then small triangles will appear in cells when it believes there is an

error (such as the multiple leading zeros in category numbers, etc.).

A A B C D E F G H I i) K
1 REMOVING GUARDRATL

2

3

4 " 204.0165

5 |CATEGORY STATION TO STATION LocaTION " LF REMARKS
G

7 [ ooio 557+63" - 599+16 RT 147.00

8 I oo1o 598+15 " - 599+37 LT 122.00

9 7 ooio 599+43" - GOO+65 RT 122.00
10 " oo1o 599+65 " - 601+12 LT 147.00
11

27 o010 1202+31.28" - 1202+75.03 RT 43.75
137 oo1o 1202+48.06" - 1202+91.81 LT 43.75
14 " oo1o 1203+19.03" - 1203+62.78 RT 43.75
15" oo1o 1203+35.817 - 1203+79.56 LT 43.75
16 r
17 " TOTAL 0010 713,00
18 r
1in
Figure A-4.5 Excel error checking displaying small triangles in cells — will also display in PowerPoint.

To stop Excel from displaying these error triangles, select FILE > Options > Formulas. Then under “Error
Checking,” unselect “Enable background error checking”.

Wisconsin Department of Transportation

68



Quantities 2 Plans User Guide

Excel Options ? X
General -_‘ . . ‘
_ \_fx Change options related to formula calculation, performance, and error handling.
Formulas ]
Data Calculation options
Proofing Workbook Calculation®d [ Enable iterative calculation
Save ® Automatic Maximum lterations: | 100 -
] Automatic except for data tables Maximum Change: 0.001
anguage

Manual
Ease of Access

Ad d
vanee Working with formulas

Customize Ribb
ustomize mibbon [] R1C1 reference style @

Formula AutoComplete 'V
Add-ins Use table names in formulas

Quick Access Toolbar

Trust Center Use GetPivotData functions for PivotTable references

rror Checking
[] Enable background error checking

Reset Ignored Errors
Indicate errors using this color: ﬁ =

Error checking rules

Cells containing formulas that result in an error‘U Formulas which omit cells in a region ‘v
Inconsistent calculated column formula in tables 'V Unlocked cells containing formulas ‘&
Cells containing years represented as 2 digits ‘4 [] Formulas referring to empty cells @

Numbers formatted as text or preceded by an apostrophe 'V Data entered in a table is invalid “*

Formulas inconsistent with other formulas in the region ‘v

Figure A-4.6 Disabling Excel error checking.

A-5 “Tab” Key Does Not Work in Newly Created MQ Sheet
There is a known bug that when creating a new MQ sheet, the “Tab” key will not work on that sheet at
first. The solution is to switch to a different MQ sheet and then switch back to refresh its functionality.

A-6 Renaming MQ Sheet Via Right-Click Inhibits Q2P Functionality
If an MQ sheet is renamed via the Excel right-click menu instead of using the proper “Rename MQ Sheet”
command, that MQ sheet will no longer be recognized as a Q2P sheet and all the Q2P commands will
cease functioning on that sheet. To rectify this, simply right-click again to revert the name to its original
name. If necessary, use the “Create MQ Sheet” command to bring up the window and scroll to one of the
bid items on the renamed sheet and that will showcase the original sheet name.
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Miscellaneous Helpful Information

Getting Help

Request help with Quantities 2 Plans by contacting the region Q2P power users in your office found here

or by sending an email to DOT Q2P Support. If the issue is believed to be more of a general problem with

Excel or PowerPoint, WisDOT staff should contact the DOT IT Service Desk.

Quick Navigation

There are several ways to quickly navigate between the “Bid Items” worksheet and the MQ sheets.

To navigate to the “Bid Items” worksheet, users can use either of the following:

1. From the Q2P ribbon, Q2P > Tool > Go to “Bid Items”.

1234-56-78_magw.xlsx - Excel

Home Insert Formulas Data Review BLUEBEAM Acrobat

Q Tell me what you want to do

Page Layout View Developer Inquire

Tj 41 Project Setup B]Published Bid ltems = *=Create MQ Sheet =X Remove Bid ltem &) Update Bid Item(s) =[] To Estimator XML From Estimator XML > About
[Z4 Category Setup F,: Project Bid Items =] Rename MQ Sheet «j{ Insert Bid Item(s) - Go to "Bid ltems” EE)TO AWP Precon XML [3 From AWP XML
e [# Checked By E Rebuild References O Round Up Quantity AE: Order MQ Sheets  [='Generate Cost Report
Project Data MQ Sheet Tool Export Import Help ~
Figure B-2.1 “Go to “Bid Items”” command.
H A . up: ”

2.  From an MQ sheet or summary sheet in any cell, Right-click > Return to “Bid Items”.
.{4|Aic|D|Eﬁ G H 1 i k U M NoF o [rREEE v|[u| v [wix[ v [z]| an [-
P Based on: HMA = 112.00 los/in/sy
%_ Agphalt Pavement Tack Coat (from “Rules of Thumb® sheet) = 0.05 gal/sy between layers
5] | LOWER LAYER | UPPER LAYER
6 4550605 4606223 4606424  465.0105 I 3MT 58285 I 4MT S8-28H

A HMA Calibrili~8 A A" $-% 9 &
Tock  PavementS Pevementd  Asphaliic AAS$-%
7 Cost  MTS3-285%* MTSE28H'* Surface B I.O-A-_-fds o L 4 voL
B |CATEGORY STATION TO STATION  LOCATION GAL TON TON TON REMARKS SF SY | W]y TUN W ss* | TON
10:008P - 1266587 &Y - - - 51 . | S 1300 10088027 50.44

0010 240+55 247474 LT&RT 213 s 477 = - 382 €O Return to "Bid Items” 200 952995.56 476.50)
11 242461 243026 o - - - 10 PRIVATE BIKE PATH 7. - 300 1968960 9.84
12 250+30 258440 LT&RT 120 23 268 . - 215% & Quantity Link 00 535957.33 267.99)
13] 251455 251475 T - - - - - 107,

14 252433 253419 A4 - - . 7 DRIVEWAY sag 3 Cut 200 1363911 682
}g TOTAL 0010 333 1211 745 6 By Copy
17 = AD Paste Options:
}g 0030  450+898L - 4S1+47BL AT 28 PARKING LOT 2192 i G 200 455644 27.28

- EE
20 TOTAL 0030 0 ) 0 - )
7] Paste Special...
% PROJECT TOTAL 333 1211 745 B Sinait Laslun
24 PLACE THE 5° HMA PAVEMENT IN TWO LAYERS, A 3.25" LOWER LAYER AND A 2° UPPER LAYER €5 Translate
25 *BASED ON 0.05 GAL/SY APPLICATION RATE —
g; **BASED ON 112 LBS/IN/SY Insert...
28 Delete...
23%- Clear Contents
31
32
33; Filter »
35 Sort 3
336_1' f:' Insert Comment
gg: Format Cells...
g Pick From Drop-down List...

Define Name...
8
& Link E
a4 & N
4 » .| 305-Base Aggregate | 416-Concrete | 460.2000 & 465- It Pavement | 506-¢.. (3 : ¢ | D

nn

Figure B-2.2 “Return to “Bid Items”” command from the right-click menu.

Wisconsin Department of Transportation
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To navigate to a desired MQ sheet or summary sheet:

- 5 - . . ______
1 Conduit Rigid Nonmetallic Schedule 40 2-Inch 2
Quantity Link
Cut

Copy
Paste Options:

B

Paste Special...

Go to MQ sheet X

652.0225 is included in the following MQ sheet(s):

652-Conduit ] Smart Lookup
652-Conduit and Wire

Translate

Insert Row

Delete Row

Clear Contents

Quick Analysis

Filter

Sort

Format Cells...

Pick From Drop-down List...

Define Name...

& Link

Figure B-2.3 “Go to MQ sheet” dialog from the right-click menu.

From the “Bid Items” worksheet, select the desired bid item.

Select desired MQ sheet or summary sheet.
Select “Go.”

A wNPE
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Users can also use Excel’s native quick navigation:

15
16
}; 1 Activate ? bt
19
20 Activate:
21 Bid tems 2 A
22 | 201-Clearing and Grubbing
23 | 203.0200.01
24 203.0500.5.07
25 | 204-Removals
26 | 208-Earthwork
27 212.0100.01
28 | 305-Base Aggregate
29 | 416-Concrete
30 460.2000
31 | 465-Asphalt Pavement
32 | 506-Structure
33 | 517-Structures 2
34 646.3020
35 | 646-Pavement Marking
36 652-Conduit
37 | 652-Conduit and Wire
38 SPV.0035.04
39 SPV.0035.08
40 SPV.0035.50 v
a1
a O 1 oo
< » .. 213.0100.01 305-Base Aggregate | 416-Concrete
Ready %1

Figure B-2.4 Right-click menu from bottom left arrows displaying all sheets.

1. Right-click on bottom left arrows.
2. Scroll to desired worksheet.
3. Select “OK.”

Excel® Tips and Tricks
To bypass automatic formatting of data in a cell, insert an apostrophe in front of the data.

The format painter tool ¥ under Home > Clipboard is useful for quickly copying the

formatting of one cell or range to another.
To quickly flip though worksheets, use Ctrl + Page Up/Down.

Excel will only sort data that is contiguous to the initial selection. Also, even if the data is contiguous,
it will not sort outside of an autofilter group.

The N function can be repurposed for inserting comments into formulas. Using it will add 0 to the end
of the formula, as the N function generally converts text (other than TRUE) to 0. This is cleaner than
using Excel comments as it will not show a red triangle in the cell. Append a formula with:

+ N(“This is the comment”)
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B-4 Complex Formulas
In addition to relatively simple computations, more complex formulas can be written.

One common reoccurring issue with permanent signing MQ sheets is that stop signs have their SF
calculated from the entered length X width (with a simple unrounded formula such as “=U9*W9/144"),
rather than octagonal area. The correct value from the sign plate can be used by using a lookup table:

=IF(K9="R1-1",VLOOKUP(U9,tables!$B$7:$C$14,2,FALSE),
IF(K9="ZX-X",VLOOKUP(U9, tables!$B$79:$C$86,2,FALSE),
IF(ISNUMBER(SEARCH("M",K9)),"-",

IF(ISBLANK(K9),"",

ROUND(((U9*W9)/144),2)))))))))

R1-1 sTOP

SIZE W (A) SF
1 24 3.31
2s 30 5.18
2M 36 7.46
3 36 7.46
4 48 13.25
5 48 13.25
6 18 1.86
7 12 0.78

Figure B-4.5 Excerpt from tables worksheet. (Lookup array highlighted)

Additional formulas can be used to show category subtotals on the “Bid Items” worksheet.
For CATEGORY 0010, with the quantity to be reported in column N:

=IF(A13<>"Xx","",IF(ISERROR(INDIRECT("TOTAL"&B13&"_0010")),"<CAT>",(INDIRECT("TOTAL"&B
13&"_0010"))))

For CATEGORY 0010 cost:

=IF(A13<>"x","" IF(N13="<CAT>","<CAT>" IF(ISERROR(D13),0,IF(D13="",0,IF(D13="
" 0,IF(D13="<Error>",0,F13*N13))))))

Adjust the red values for each category/location. These formulas can cause slowdowns in Excel with larger
projects.

: It is important to always build a formula that other users will be able to understand. That might
require using individual cells that are labeled for both variables and constants.

Other formulas can be written with Excel for computing incentives, etc.

Q2P users are encouraged to submit their custom formulas or workflows to DOT Q2P Support, so they can
be added to the User Guide or otherwise shared.
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B-5 Making Notes in Q2P

o3
'
2

X X X X X X X X X

q

On the “Bid Items” worksheet, the columns past column G (except for column K and L) can be used to
make notes about any particular item that is suitable for Estimate Documentation. Unit price source
information and tagging the items in the FIIPS Preliminary Quantities groups are the most common notes
recorded in Q2P.

: Column K and L should be avoided as the command for importing prices from Estimator and AWP
will overwrite these columns. Extraneous columns including K and L can be hidden when
formatting the estimate documentation.

B © D E F G H J K L M N o P -
ENGINEER'S ESTIMATE / Q2P WORKBOOK CONSTRUCTION COST ESTIMATE
PROJECT MANAGER: John Doe $0.00

CONST. I.D.: 1234-56-78

TITLE: WAUKESHA - SUPERTOR

LIMITS: GREEN BAY TO LA CROSSE

HIGHWAY: STH 1

COUNTY: Adams PSE Date: 6/19/2019

PROGRAM CODE: 303 STATE HIGHWAY REHABILITATION Let Date: 6/19/2019
CONCEPT CODE: RESURF RESURFACING NET C/L M1 0.000

TOTAL BID SCHEDULE OF BID ITEMS WISDOT STANDARD SPECIFICATIONS ‘ ESTIMATOR AwP
ITEMS | PRICE  PRICE [ESTIMATOR

415.0090 Concrete Pavement 9-Inch 0 sy $0. 00|
465.0105 Asphaltic surface 0 ToN $0. 00|
SPV.0060.01 special (01. Ancient Pyramid Excavation) 0 EACH $0. 00|
SPV.0090.01 special (01. varn) 0LF $0. 00|

9 - ITEM DESCRIPTION 3 QUANTITY - UNIT - [UNIT PRI( - | cosT ~JEIIPS QUANTITIES IMPORT IMPORT| 6/1/2019 PAST PROJECT

201.0105 Clearing 0 STA $0. 00|
201.0205 Grubbing 0 STA $0. 00|
204.0105 Removing Pavement Butt Joints 0 sy $0. 00|
305.0115 Base Aggregate Dense 3/4-Inch 350 cy $0. 00| 9876-54-62 Price
305.0125 Base Aggregate Dense 1 1/4-Inch 350 cv $0. 00f

CONSTRUCTION TOTAL: $0.00

DELIVERY COST: 15.(@ $0.00
TOTAL : $0.00 -
Bid Items | 201.0105 | 201.0205 | 204.0105 | 305.0115 | 305.0125 | 415.0090 | 465.0105 | SPV.0060.01 | ... (® < »
Figure B-5.6 Making notes in Q2P.

The commonly used abbreviations for FIIPS Preliminary Quantities (Roadbuilder Quantities) are:

ASPH (Asphalt Pavement TON), CONC (Concrete Pavement SY), EXCV (Excavation CY), BCRS (Base Course
TON), BRDG (Bridge SF), MILL (Milling SY), GRND (Diamond Grinding SY), STRP (Pavement Marking LF), and
RUBL (Rubbilized Pavement SY). Obviously, some quantities need to be converted to the correct unit of
measure prior to being totaled for entry into FIIPS.

The notes can serve as the required documentation of how unit prices were arrived at for the engineer’s
estimate (for the 80/20 rule items). When making notes about unit price sources, be sure to include a
general project statement as to whether or not “one bidder” was assumed.

B-6 Finding Contingency Let Dates in FIIPS

Wisconsin Department of Transportation

The Earliest Possible Let is obtained from the FIIPS. These are considered to be Priority 1 advanceable and
have the PS&E submitted early. Priority 2 code projects are ones that are the top region priority for
advancement and C.O. may request the PS&E package as needed. The regions may also have priority 10
contingency projects that don’t have early lets in FIIPS and are just kept for regional balancing due to
individual project delays, etc. rather than statewide program issues or unbalanced lettings.

Find the earliest possible let in FIIPS by checking Project > Estimate... and view the LET project information.
If the “Earliest schedule date” differs from the “Schedule date” then the project is a priority 1 contingency
and must be submitted early. PMP should have the base schedule set to the earliest date and the project
developed accordingly.
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This contingency date can be manually added to Q2P, above the PSE Date field, if the designer finds that
information helpful to display.

Consultants should request this information from the WisDOT Project Manager.

Wisconsin Department of Transportation lTl—
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Appendix C. Confidentiality of Engineer’s Estimate and Pre-award Bid Data

: “&\scow%‘
gy g

CORRESPONDENCE/MEMORANDUM 1%&%‘rT\=«r~“““{§:

DATE: April 10, 2017

TO: DOT Staff and Design Consultants

FROM: Scott Lawry, Chief Proposal Management Engineer

SUBJECT:  Confidentiality of Engineer’s Estimate and Pre-award Bid Data

As a reminder, the engineer’s estimate and bid tab information, prior to award, are confidential. The
release of this information may compromise the integrity of the competitive bidding process and cause
harm to contractors and the Department. Individuals that knowingly release this information may be
subject to discipline.

The engineer’s estimate is confidential before, during and after the letting.

FHWA has stated, even after the project has been built, the engineer’s estimate should not be released
outside the department with the exception of the FHWA and engineering consultants working directly
for the department on the project in question. The FHWA Office of Program Administration in
Guidelines on Preparing Engineer’s Estimate, Bid Reviews and Evaluation and the FHWA National
Review Program in National Review of State Cost Estimation Practice provide the basis for preserving
confidential estimates. Confidential estimates ensure market conditions are reflected within the bids and
maintain a more competitive environment.

The department publishes an estimate range which can be found at

http://wisconsindot.gov/Pages/doing-bus/contractors/heci/mstr-cntret-sched.aspx.

Bid tab information, prior to award of the contract. is confidential
Bid tab information (contractor’s bids on individual items) will not be publicized until the proposal is

awarded. The Bureau of Project Development Proposal Management Section may share bid tab
information with the design engineer during the bid analysis process to assist in evaluating the proposal
and 1n particular as it relates to unbalancing. The concern arises when all bids are rejected. It is possible
that bidders may want to use some of the submitted unit prices for subsequent bid lettings on the same
proposal. Release of this information compromises the competitive bidding process.

After the proposal is awarded, bid tab information is posted on the HCCI and Bid Express websites.
To address confidentiality concerns, access to bid letting reports is restricted. If you require access to
confidential bid letting reports, please contact Proposal Management at DOT DTSD BPD Proposal

Management Section.

Thank vou for supporting our efforts to maintain this needed confidentiality.
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